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1 Getting Started

This documentation describes how to configure and administer SAP GUI for Windows.
i Note

You can find more information in the Frontend Installation Guide, the Security Guide, and the End User

Guide. These documents can be found in the documentation folder of the DVD, on the SAP GUI Family Page
in SAP Community® or in the SAP Help Portal.

SAP GUI Scripting security details can be found in the SAP GUI Scripting Security Guide.
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2 Application Data Directories

Windows offers dedicated directories in which applications can store their application-specific data like
configuration files, temporary files, etc. There are three application data directories:

One is intended for data that should be available to roaming users on whatever machine they log on to.
This is the application data directory located directly below the user profile directory and it can be reached
using the environment variable <%APPDATA%>.

The second application data directory is intended for data that will only be needed on the local machine,
i.e. it will not be missed by a user when he or she logs on to a different machine. The data in this
directory is not available to roaming users. This directory can be reached using the environment variable
<%LOCALAPPDATA%>.

And one directory for files downloaded by the user:< C:\Users\<username>\Documents\SAP\SAP
GUI>

2.1 Roaming User Application Directory

The configuration files of the SAP GUI are located in the roaming user application directory as shown in the
following file/location overview.

6

The local SAP Logon configuration file SAPUILandscape.xml is located in
%APPDATA%\ SAP\Common

Input History database:

%APPDATA%\SAP\SAP GUI\History

i Note

The directory for the history database can also be set to another default with the variable

<SetSapGuiHistoryDir> while creating installation packages using the SAP Installation Server
Administration Tool.

The corresponding registry value is
[HKEY_LOCAL_MACHINE\Software\SAP\SAP Shared] SaphistoryDir (32bit operating system or
64bit version of SAP GUI for Windows) and

[HKEY_LOCAL_MACHINE\Software\Wow6432Node\SAP\SAP Shared] SaphistoryDir (32bit SAP
GUI for Windows on a 64bit operating system) .

Use type Expandable String Value (REG_EXPAND_SZ), do not use string!

Local Tab Order database:

%APPDATA%\SAP\SAP GUI\LocalTabOrdexr

ABAP Editor Configuration:

%APPDATA%\SAP\SAP GUI\ABAP Editor

Floating Docking Container Configuration:

SAP GUI Administration
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%APPDATA%\SAP\SAP GUI\Docking
* SAP GUI Scripts
%APPDATA%\SAP\SAP GUI\Scripts

2.2 Local User Application Directory

In the local application data directory, temporary files, traces etc. are stored.
* Folder for temporary documents:

%LOCALAPPDATA%\SAP\SAP GUI\tmp

A\ Caution

Documents in the temporary directory will be deleted, when SAP GUI is closed. You can configure the
deletion of files also in other directories. For information on this, refer to the security guide.

* Files downloaded by the user:
C:\Usexrs\<username>\Documents\SAP\SAP GUI

i Note

The directory for the downloaded files can also be set to another default with the
variable SETSAPWORKDIR while creating installation packages using the SAP Installation Server
Administration Tool.

The corresponding registry value is

[HKEY_LOCAL_MACHINE\Software\SAP\SAP Shared]\ SapWorkDir (32bit operating system or
64bit version of SAP GUI for Windows) and

[HKEY_LOCAL_MACHINE\Software\Wow6432Node\SAP\SAP Shared]\ SapWorkDir (32bit SAP
GUI for Windows on a 64bit operating system)

Type: Expandable String Value

A\ Caution

The installer of the SAP GUI for Windows sets this value only, if a value has been specified in the SAP
Installation Server Administration Tool. Therefore, it cannot be assumed that this registry value will
exist on a client PC.

The folders for the temporary and user documents should, therefore, be determined by ABAP
programs using the corresponding methods in the class CL_GUI_FRONTEND_SERVICES. The
temporary document folder can be obtained using the method GET_TEMP_DIRECTORY and the
document directory can be retrieved by means of the method GET_SAPGUI_WORKDIR.

* Cache:
%LOCALAPPDATA%\SAP\SAP GUI\Cache
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i Note

It would not make sense to have the cache in the roaming directory, because it is a local cache.
Accessing the cache over the network would nullify the advantages that it would otherwise provide:
direct and quick access to an object without a network in between.

Traces:

%LOCALAPPDATA%\SAP\SAP GUI\Traces

Edge Control

%LOCALAPPDATA%\SAP\SAP GUI\EdgeUserData

Folder for temporary Internet files downloaded / created by the Edge (WebView?2) browser control. This
folder is only used, if the alternative browser control was activated.

You can activate the Edge control on the Control Settings Page [page 66]. And you can delete the directoy
on the File Lifetime Page [page 79].
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3 Data Migration for End Users

As of SAP GUI for Windows 7.60 Patchlevel 3, a new function is available in the Restore & Clean Up Page [page
927 with which end users can export their local SAP GUI-specific settings and reimport them. This is for
example useful, when the desktop computer of a user is exchanged and the SAP GUI-specific settings should
be reused on the new machine.

The following settings are exported:

* SAP Logon entries of the user (connections, shortcuts, favorites, ...)

¢ user-specific settings of the SAP GUI configuration in the Windows registry

® security rules created by the user

® input history of the user

* the database with the local tab order created by the user

* settings of the new ABAP editor

* Theme colors settings made by the user (see Setting Theme Color [page 22])

* Branding image, which the user stored locally (see also Using Default Branding [page 16]). During import,
the branding image is copied to the old location in the file system. If this does not function, the branding
image is copied to a default location and the user is informed that the settings for the branding image still
have to be adapted.

The Export option opens a dialogue where the user can enter a file name. This file then contains the export of
all the above-mentioned data in compressed form.

iNote
The compressed file is protected by a user-specific password to prevent unintentional transfer to another

user and, thus, to guarantee the consistency of the export.

The Import option opens a dialogue where the user can choose an export file to be imported. Only files created
during an export out of SAP GUI will be displayed as selection

i Note
After confirming the dialogue, all current user settings of SAP GUI will be overwritten. Furthermore, all SAP
GUI windows as well as the SAP Logon have to be closed and restarted after import, so that the settings
can take effect.
To disable the import/export function, use the Read-Only feature together with the following registry values:
[HKEY_LOCAL_MACHINE\SOFTWARE\SAP\General\Appearance]
ImportConfigurationAndSettings_ReadOnly [Default: 0]
ExportConfigurationAndSettings_ReadOnly [Default: 0]
See also, Read-Only Feature of the SAP GUI Options Dialog [page 27].
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4 SAP Logon Configuration

Before SAP GUI for Windows 740 was released, you had to use the old configuration format for SAP Logon
entries (saplogon.ini, sapmsg.ini, saproute.ini). With SAP GUI for Windows 7.40, the new configuration format
SAP Ul Landscape was introduced. This new format had beend created to simplify the configuration by unifying
the persisted connection and connection configuration data from SAP GUI for Windows, SAP GUI for Java and
SAP BC in a modern and easy way:

* There are less configuration files involved and they are stored in the same directory.

¢ Configuration files can either be stored locally or on a central server or share.

* Deployment options “pull” and “push™ are available.

* The configuration files are the same for SAP GUI for Windows, SAP GUI for Java and SAP BC.

¢ |f SAP GUI has been used already, the connection data will be migrated automatically into the SAP Ul
Landscape format.

In the interim period (SAP GUI for Windows releases 7.40 and 7.50), you had the choice between the
conventional or classic installation procedure/configuration format and the new file format SAP Ul Landscape.

i Note

As of SAP GUI for Windows 7.60, the old configuration format is not supported anymore. SAP GUI

for Windows can still handle this old format for compatibility reasons, because there may be external
applications needing this old format, but using SAP GUI for Windows 7.60 with the old format is not
supported. SAP will neither test this format nor correct issues affecting it. Therefore, all installations of SAP
GUI for Windows 7.60 and newer must use SAP Ul Landscape.

See also:

¢ SAP Ul Landscape Configuration Guide
¢ SAP Frontend Installation Guide
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5 Browser Control Fallback Configuration

As of SAP GUI for Windows 7.70 an alternative browser control used for displaying HTML content in the SAP
GUI HTML Control is available (see also SAP Note 2913405# ). In previous releases, SAP GUI always used
Internet Explorer to display HTML content, but as of release 7.70, the WebView?2 control (Edge based on
Chromium) can be used as well.

i Note

As of SAP GUI for Windows Release 8.00, the Edge-based HTML Control is the default.

Since there is quite a lot of HTML content available which is not or not totally compatible with modern browsers
like Edge, you may wish to keep using the Internet Explorer for some SAP systems or applications while using
Edge as the default browser. You can achieve this by configuring the corresponding browser control fallback.

i Note

HTML content which is not compatible with modern browsers should be made compatible if possible. It is
likely that Microsoft will stop support for the Internet Explorer control sooner or later and at that point of
time, Edge will be the only available browser control to use in SAP GUI for Windows.

Fallback Mechanism

The fallback mechanism allows you to configure exceptions to the usage of Edge (based on Chromium) as the
browser control in SAP GUI for Windows. This can be used in cases where incompatible content is supposed to
be used until it gets replaced. The feature is only available, if the Browser Control is configured as Edge (based

on Chromium) in the SAP GUI Options dialog (under ||+ Interaction Design » Control Settings ). For being able
to configure Edge as browser control a sufficiently new version of the WebView?2 control is required on the client
PC.

The fallback mechanism consists of the following steps:

1. Definition of the Fallback Rules File [page 12]
2. Deploying the Fallback Rules File [page 13]
3. Trace for Fallback Functionality [page 13]

Related Information

Changes in Detection of Transaction and Screen [page 14]

SAP GUI Administration
Browser Control Fallback Configuration PUBLIC 11


http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/
			2913405

5.1 Definition of the Fallback Rules File

To use Internet Explorer instead of Edge in some systems, transactions or screens, you can create an XML file
with the following format (sample):

‘=, Sample Code

<?xml version="1.0" encoding="UTF-8"?>
<SAP>
<type>SAP HTML Control Fallback Rules</type>
<version>1.0@</version>
<timestamp>2020-08-12 15:00:00</timestamp>
<rules>
<rule system="SY1" transaction="TAl" browsercontrol="Internet
Explorer" />
<rule system="SY2" transaction="TA2" browsercontrol="Edge" />
<rule system="SY2" transaction="*" browsercontrol="Internet Explorer" />
<rule system="SY3" transaction="TA3" browsercontrol="Internet
Explorer" />
<rule system="SY3" transaction="TA4" screenname="SCREENNAME1"
screennumber="SCREENNUMBER1" browsercontrol="Internet Explorer" />
</rules>
</SAP>

i Note

The information on systems, transactions and screens, of course, needs to be updated by you. SY1, SY2,
SY3, TAL, TA2, TA3, TA4, SCREENNAME1 and SCREENNUMBERI are just placeholders in the example
above.

The primary section in the XML is the <rules> section which contains the individual rules overriding the
default configuration. SAP GUI processes these rules until a matching rule is found (it picks the first matching
rule from the top). If no matching rule is found, the default setting (Edge) is taken.

The rules above have the following effects:

1. Insystem SY1, all applications use Edge with one exception: Transaction TAl uses Internet Explorer.
2. Insystem SY2, all applications use Internet Explorer with one exception: Transaction TA2 uses Edge.

3. Insystem SY3, all applications use Edge with two exceptions: Transaction TA3 uses Internet Explorer for all
screens and transaction, TA4 uses Internet Explorer for screen SCREENNAME1, SCREENNUMBERLI.

4. For all other systems Edge is used.

i Note

* You can leave out parameters:

* If systemis not supplied or supplied as system=*, the respective rule matches all systems.

* If transaction is not supplied or supplied as transaction=%*, the respective rule matches all
transactions.

* |f screenname is not supplied or supplied as screenname=*, the respective rule matches all
screennames.

* If screennumber is not supplied or supplied as screennumber=*, the respective rule matches all
screenumbers.

SAP GUI Administration
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* |f browsercontrol is not supplied, the default will be used.
* Patterns with placeholders (like SY*) are not supported.

* You can determine the system ID and the transaction code you need to create rules for via the system
information area in SAP GUI. To determine the name and the screennumber (if you need this granular
check), we recommend using the trace explained in section Trace for Fallback Functionality [page 13].

* The fallback configuration file cannot be provided by SAP, because the content of the file depends on
your own requirements (which HTML content is embedded).

Related Information

Deploying the Fallback Rules File [page 13]

5.2 Deploying the Fallback Rules File

Once the Definition of the Fallback Rules File [page 12] has been created, you need to place it on a file share or
HTTP(S) server and make sure the users can access this file.

Then you create a registry value called BrowserControlFallbackConfiguration (type REG_SZ) under

¢ HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\SAP\General (64bit operating system, when
running a 32bit version of SAP GUI for Windows) or

* HKEY_LOCAL_MACHINE\SOFTWARE\SAP\General (32bit operating system or 64bit operating system,
when running a 64bit version of SAP GUI for Windows) or

* HKEY_CURRENT_USER\SOFTWARE\SAP\General

on the client PCs and assign the full path including the file name of the fallback file to this value. For example:
\\<server>\SAP_GUI\BrowserControlFallback.xml
https://<server>:<port>/SAP_GUI/BrowserControlFallback.xml

The reading priority of the registry value above is HKEY_CURRENT_USER and then HKEY_LOCAL_MACHINE. If
no fallback rules file is configured or the file cannot be read, the default browser control will be used for all
systems, transactions and screens.

You can add such registry settings to your SAP GUI installation package via NWSAPSetup (see the SAP
Frontend Installation Guide).
5.3 Trace for Fallback Functionality

As of patchlevel 3 of SAP GUI for Windows 7.70 in case of issues, you use an SAP GUI trace to get to the root
cause of the issue.

SAP GUI Administration
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Proceed as follows to activate the trace:
Invoke the SAP GUI Options dialog.

In the options dialog, navigate to the page | Tracing ¥ Session Tracing 3.
From the listbox showing the available traces, select General.

AW

Select the checkbox Detailed output.
5. Click the button Enable.

Then you reproduce the issue, turn off the trace again and check the trace file.

The trace file contains lines like:

<29=Monitor: SAPBrowserConfManager::GetAllowedBrowserStr Use input parameters: transactionName:
<CURRENT TRANSACTION CODE>; screenName: <CURRENT SCREEN NAME>; screenNumber: <CURRENT
SCREENNUMBER>

<29=Monitor: SAPBrowserConfManager::GetAllowedBrowserStr Rule match: systemName: <SYSTEM ID
USED IN RULE>; transactionName: <TRANSACTION CODE USED IN RULE>; screenName: <SCREEN NAME
USED IN RULE>; screenNumber: <SCREEN NUMBER USED IN RULE>

<29=Monitor: SAPBrowserConfManager::GetAllowedBrowserStr return browserName: Internet Explorer

The parts enclosed in <> contain the data that is compared to check whether a rule you created applies to the
current system, screen, and so forth.

Related Information

Changes in Detection of Transaction and Screen [page 14]

5.4 Changes in Detection of Transaction and Screen

Prior to SAP GUI for Windows 7.70 patchlevel 7 and the ABAP corrections from SAP Note 3153691, it

wasn't always possible to determine the correct transaction code or screen, because the automation queue
which creates the SAP GUI controls including the HTML control is processed before SAP GUI gets updated
information on a changed transaction or screen from the application server. This caused issues in the following
scenarios:

* You have defined a fallback rule using a transaction code and the HTML Control is immediately created at
the start of this transaction (like for example in transaction SE80).

* You have defined a fallback rule using a screen name or number and transaction creates the HTML Control
immediately when the new screen is displayed (an example for this would be transaction DWDM which can
start some demo reports with HTML Controls on the first screen).

With the functional extension, this restriction is removed, because SAP GUI for Windows gets current

information on transaction and screen from the application server at the right point of time. However,

this can also mean that a rule that has been working in the past is no longer working as expected after
the update (because now SAP GUI gets the proper data). In such a case, you need to adjust the rule

SAP GUI Administration
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accordingly. You can use the Trace for Fallback Functionality [page 13] to determine the right parameters
for the rule.
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6 Branding Settings

It is possible to display different branding logos in SAP GUI for Windows. The branding settings can be defined
in the following ways:
* As SAP GUI default (set in the SAP GUI options dialog), see Using Default Branding [page 16]

* Assystem- or client-specific setting (set in the SAP GUI options dialog), see also Using System/Client-
specific Branding [page 171].

6.1 Using Default Branding

You can integrate a default company/branding logo in the titlebar of a SAP GUI session. This default logo is
displayed as long as there are no system- oder clients-specific settings (see also Using System/Client-specific

Branding [page 17]). In the SAP GUI Options dialog (|l Visual Design » Branding 3), this feature is set read-
only by default.

Prerequisites

* The feature cannot be used for Classic Theme.

* The size and format of the logo should be as follows: The optimal height for the picture is 27 pixel. The
shown width can be up to 160 pixel, but only if the height of 27 is not exceeded.
If the picture does not fit in size, then the picture will be scaled so that it fits the optimal height of 27 pixel.
The width will be scaled symmetrically to the maximal allowed height or asymmetrically to fit the maximal
allowed width.

Procedure

1. Torollout the settings to the users, create the following registry keys:

[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\SAP\General\Appearance] (32bit SAP GUI for
Windows on a 64bit operating system)

[HKEY_LOCAL_MACHINE\SOFTWARE\SAP\General\Appearance]

UseBrandingImage (REG_DWORD) = 1 (activates the display of a logo in the titlebar of a SAP GUI
session, if a valid path to a branding picture is provided)

BrandingImage (REG_SZ) with path name to picture as value data:
C:\<PathToBranding>\<YourCompanyBranding>.png

SAP GUI Administration
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By default the branding feature is not editable by the user. Therefore, the users can see the above set

values on the page [ Visual Design ¥ Branding 7 in the SAP GUI Options dialog, but they cannot change
the settings because these are read-only.

. Optional: In order to allow users to set this option from the SAP GUI Options dialog, you need to create the
following registry values:

[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\SAP\General\Appearance] (32bit SAP GUI for
Windows on a 64bit operating system)

[HKEY_LOCAL_MACHINE\Software\SAP\General\Appearance]

UseBrandingImage_ReadOnly (REG_DWORD) =0

BrandingImage_ReadOnly (REG_DWORD) =@

After restart of the SAP Logon, the settings on page [» Visual Design » Branding 3 will be editable. When a

user changes the settings, the SAP GUI Options dialog writes these values to the following registry values
under HKEY_CURRENT_USER:

[HKEY_CURRENT_USER\Software\SAP\General\Appearance]
UseBrandingImage (REG_DWORD)

BrandingImage (REG_SZ)
i Note

The HKEY_CURRENT_USER values have a higher priority than values under HKEY_LOCAL_MACHINE.

6.2 Using System/Client-specific Branding

In addition to Using Default Branding [page 16], you have the possibility to set a branding logo per system or
per client (for SAP systems with a kernel in which the SAP note 1617682 # is built in). This might be helpful, if
you are hosting systems for other customers or if you want to achieve a better distinctness of GUI windows to
different SAP systems/clients. System- and client-specific settings overwrite the default settings.

Prerequisites

For the size and format of the logo, see the Prerequisites section of Using Default Branding [page 16].

Itis recommended to roll-out the images via NWSAPSetup, see also section Configuring Packages and
Scripting Events in the SAP Frontend Installation Guide.

The branding images must be saved in the SAP GUI installation directory (see also section 'Branding Root
Folder' below).

i Note

The Branding folder should contain only valid pictures. In the Options dialog, SAP GUI shows all files for
selection, however, files that are not valid picutres will not be displayed as branding images at runtime.
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The branding directory must be structured in the following way (SID1 stands for the system ID of the first
system, SID2 for the one of the second system):

* SID1
* Clientl
* Logofile
* C(Client2
* Logofile
* Client3
* Logofile
* SID2
* Clientl
* Logofile
* C(Client2
* Logofile
* Client3
* Logofile

Branding Root Folder

The default branding root folder is part of the SAP GUI installation directory and is named Branding, for
example C: \Program Files (x86)\SAP\FrontEnd\SAPgui\Branding. The administator can change this
path via registry:

[HKEY_LOCAL_MACHINE\SOFTWARE\SAP\General\Appearance\Systems]

[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\SAP\General\Appearance\Systems\] (32bit SAP
GUI for Windows on a 64bit operating system)

Foldex4SystemSpecificBranding (REG_SZ) {Default: "Branding" in SAP GUI InstallDir}

i Note
The reading priority for this registry value is as follows:

HKCU — HKLM — Default

Registry Values

System-specific Rollout

To roll out the branding setting for a specific SAP system, create the following registry key and values under
HKEY_LOCAL_MACHINE:

[HKEY_LOCAL_MACHINE\SOFTWARE\SAP\General\Appearance\Systems\<SID>]
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[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\SAP\General\Appearance\Systems\<SID>] (32bit
SAP GUI for Windows on a 64bit operating system)

(replace SID by the sytem ID of your SAP system)
BrandingImage [REG_SZ] (Pathto Branding Image without Root-Folder: <SID>\Logo.png)
Client-specific Rollout

To roll out the branding setting for a specific client in a SAP system create the following registry key and values
under HKEY_LOCAL_MACHINE:

[HKEY_LOCAL_MACHINE\SOFTWARE\SAP\General\Appearance\Systems\<SID>\<Client>]

[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\SAP\General\Appearance\Systems\<SID>\<Clie
nt>] (32bit SAP GUI for Windows on a 64bit operating system)

(replace SID by the System ID of your SAP system and replace client by the actual client number, for example
100)

BrandingImage [REG_SZ] (Path to Branding Image without Root-Folder:<SID>\<Client>\Logo.png)

i Note

The reading priority for this registry value is as follows:

HKCU — HKLM — Default

The following image shows an example:

Computer\HKEY_CURRENT_USER\SOFTWARE\SAP\General\Appearance\Systems\YI3\000

QtProject ~ || Name Type Data
Rea!tek . ab| (Default) REG_SZ (value not set)
RegistesedApplications ab|Brandinglmage REG_SZ SAP_Logo.png
v SAP
ABAP Debugging
BEx
v General

v Appearance
v Systems
Y6B
v Yi3
[ ] 000
100

The Systems node contains the Y6B und Y3 nodes from the example above and these nodes contain the
nodes for the clients. Within the nodes, there is a registry value for every logo of type REG_SZ with the
name Brandinglmage, which contains the file name (only path without branding root folder). By setting the
corresponding registry values, the administrator can set the defaults.

Read-only Feature

The Branding in System page is by default read-only, even if the read-only feature is not activated. However,
administrators can activate the page for their users via the corresponding registry value, see Branding in
System [page 37].
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6.3 Priority of the Different Branding Configurations

The following list shows the priorities in image selection:

* If no specific branding image has been selected for a system, then the default image is displayed (if
configured).

* If no specific branding image has been selected for a client, the system image or the default image is
displayed (if configured).

* Only such logos are displayed that have been assigned by the administrator to the corresponding
combination of system and client.
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7 Setting Logon Language

The default way of setting the SAP logon language is as follows: The logon screen is displayed in the language
set in the backend system. If a user enters a SAP language during logon, this language will be used after logon.
If the user does not enter a language, the language of the user settings will be used as logon language if it is set.
If there is also no entry in the user settings, the language of the system will be used.

The logon language can be predefined in the [F SAP Logon Options ¥ General 3 dialog (option Use SAP Logon
language as default on logon screen) or in the SAP Shortcuts dialog. These language settings are sent during
connection setup to the backend. In this way, already the logon screen is displayed in the desired language and
the language field is prefilled. This functions also in case of an SSO session.

i Note

In a Portal or SAP Business Client environment, where you do not logon via a SAP GUI, an SSO2 cookie is
used for the connection setup. In this case, the SSO2 cookie language is used.

You can switch this language predefinition feature on and off for all or only for certain systems:

* If you want to switch this feature off for a certain system, define a SAP Shortcut and choose default as
language. Then, the user setting or, respectively, the backend system setting is used.

* If you want a different logon language for a certain system than the one defined as SAP Logon
language, create a shortcut with the corresponding language defined.

* If you want to switch this feature off for all systems, deactivate the corresponding option in the SAP
Logon Options dialog
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8 Setting Theme Color

It is possible to display the SAP Signature, Blue Crystal, Belize and Quartz/Quartz Dark Themes in different
color schemes. The color setting can be defined in the following ways:

* As SAP GUI Default (set in the SAP GUI options dialog)
* By system and optionally by client (set in the SAP GUI options dialog)

* Asa System default (set via a profile parameter)

The subsections below describe the different color setting possibilities from the administrator's perspective.

8.1 SAP GUI Default Color

SAP Logon and SAP GUI sessions, which use default color settings configuration on the client machine and for
which no SAP Signature, Blue Crystal, Belize or Quartz/Quartz Dark color is defined on the SAP system, are
shown in the default color.

To rollout the default SAP Signature, Blue Crystal, Belize or Quartz/Quartz Dark color to users, create the
following registry key and values under HKEY_LOCAL_MACHINE:

[HKEY_LOCAL_MACHINE\SOFTWARE\SAP\General\Appearance]

[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\SAP\General\Appearance] (32bit SAP GUI for
Windows on a 64bit operating system)

SelectedTheme [REG_DWORD] = @x1 (SAP Signature Theme)

SignatureDefaultColor [REG_SZ] (Possible values: SAP Gold, SAP Green, SAP Purple, SAP Red or
SAP Signature Default)

Or
SelectedTheme [REG_DWORD] = 0x80 (Blue Crystal Theme)

BlueCrystalDefaultColor [REG_SZ] (Possible values: SAP BC Gold, SAP BC Green, SAP BC
Purple, SAP BC Red or BlueCrystal for the default)

Or
SelectedTheme [REG_DWORD] = 0x100 (Belize Theme)

BelizeDefaultColoxr [REG_SZ] (Possible values: Belize Gold, Belize Green, Belize Purple,
Belize RedorBelize for the default)

Or

SelectedTheme [REG_DWORD] = 0x800 (Quartz Theme)
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QuartzDefaultColor [REG_SZ] (Possible values: Quartz Gold, Quartz Green, Quartz Purple,
Quartz RedorQuartz forthe default)

Or

SelectedTheme [REG_DWORD] = 0x4000 (Quartz Dark Theme)

QuartzDarkDefaultColoxr [REG_SZ] (Possible values: Quartz Dark Gold, Quartz Dark Green,

Quartz Dark Purple, Quartz Dark RedorQuartz Dark for the default)

The default theme color can also be changed via the SAP GUI Options dialog on the page | Visual Design
» Color Settings 1 (if the active theme is one of SAP Signature Theme, Blue Crystal Theme, Belize Theme

or Quartz Theme). The SAP GUI Options dialog saves the settings under the same registry key and values,
but under HKEY_CURRENT_USER. The HKEY_CURRENT_USER registry values have a higher priority than the

registry values under HKEY_LOCAL_MACHINE.

8.2 System-Specific Color Settings (Options Dialog)

For SAP systems with a kernel in which the note 1617682#% is built in, it is possible to set a different SAP
Signature, Blue Crystal, Belize or Quartz color for different clients of this SAP system:

¢ System-specific Rollout

To roll out the color setting for a specific SAP system, create the following registry key and values under

HKEY_LOCAL_MACHINE:
[HKEY_LOCAL_MACHINE\SOFTWARE\SAP\General\Appearance\Systems\<SID>]

[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\SAP\General\Appearance\Systems\<SID>]

(32bit SAP GUI for Windows on a 64bit operating system)
(replace SID by the sytem ID of your SAP system)

ThemeName [REG_SZ] (Possible values for SAP Signature: SAP Gold, SAP Green, SAP Purple, SAP

Red or SAP Signature Default)

ThemeNameBC [REG_SZ] (values for Blue Crystal: SAP BC Gold, SAP BC Green, SAP BC Purple,

SAP BC Red or BlueCrystal for the default)

ThemeNameBelize [REG_SZ] (values for Belize: Belize Gold, Belize Green, Belize Purple,

Belize Red or Belize for the default)

ThemeNameQuartz [REG_SZ] (values for Quartz: Quartz Gold, Quartz Green, Quartz Purple,

Quartz Red or Quartz for the default)

ThemeNameQuartzDark [REG_SZ] (values for Quartz: Quartz Dark Gold, Quartz Dark Green,

Quartz Dark Purple, Quartz Dark RedorQuartz Dark for the default)
¢ Client-specific Rollout

To roll out the SAP Signature color setting for a specific client in a SAP system create the following registry

key and values under HKEY_LOCAL_MACHINE:
[HKEY_LOCAL_MACHINE\SOFTWARE\SAP\General\Appearance\Systems\<SID>\<Client>]

[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\SAP\General\Appearance\Systems\<SID>\<C

lient>] (32bit SAP GUI for Windows on a 64bit operating system)
(replace SID by the System ID of your SAP system and replace client by the actual client number, for
example 100)
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ThemeName [REG_SZ] (Possible values: SAP Gold, SAP Green, SAP Purple, SAP Red or SAP
Signature Default)
ThemeNameBC [REG_SZ] (Possible values for Blue Crystal: SAP BC Gold, SAP BC Green, SAP BC
Puxple, SAP BC Red or BlueCrystal for the default)
ThemeNameBelize [REG_SZ] (values for Belize: Belize Gold, Belize Green, Belize Purple,
Belize Red or Belize for the default)

* ThemeNameQuartz [REG_SZ] (values for Quartz: Quartz Gold, Quartz Green, Quartz Purple,
Quartz Red or Quartz for the default)
ThemeNameQuartzDark [REG_SZ] (values for Quartz: Quartz Dark Gold, Quartz Dark Green,
Quartz Dark Purple, Quartz Dark RedorQuartz Dark for the default)

The color settings for SAP systems (and/or clients in system) can also be changed via the SAP GUI Options

dialog on the page | Visual Design 3 Colors in System 3 (if the active theme is one of SAP Signature

Theme, Blue Crystal Theme , Belize Theme or Quartz Theme). When logged on to the respective SAP system/
client, the SAP GUI Options dialog saves the settings under the same registry keys and values, but under
HKEY_CURRENT_USER. The HKEY_CURRENT_USER registry values have a higher priority than the registry
values under HKEY_LOCAL_MACHINE.

The registry key and values under
[HKEY_LOCAL_MACHINE\SOFTWARE\SAP\General\Appearance\Systems]

[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\SAP\General\Appearance\Systems] (32bit SAP
GUI for Windows on a 64bit operating system)

are copied at startup of SAP Logon (SAP GUI) from HKEY_LOCAL_MACHINE to HKEY_CURRENT_USER
without overwriting existing values.

8.3 System-Specific Color Settings (System Profile
Parameter)

A SAP Signature color can be defined in the SAP system via the system profile parameter sapgui/
signature_color.

Note 1640960 describes this system parameter and how to set it. This note must be part of the kernel in
order to support this feature.

For Blue Crystal Theme and Belize Theme the same functionality is available as of SAP GUI for Windows 7.60.
For Quartz Theme and Quartz Dark Theme the same functionality is available as of SAP GUI for Windows 7.70.
To activate the color settings a new profile parameter sapgui/system_color is required.

See SAP Note 2571622 for more information on the prerequisites for SAP_BASIS and SAP Kernel.

The new profile parameter sapgui/system_color can also be used to activate the color settings for SAP
Signature Theme.
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There are several ways to overwrite a color setting defined by the SAP system with a local configuration:

You can ignore the color defined by the SAP system parameter for all systems, if you create the following
registry value:
[HKEY_LOCAL_MACHINE\SOFTWARE\SAP\General\Appearance]

[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\SAP\General\Appearance]
(32bit SAP GUI for Windows on a 64bit operating system)

SignatureSystemDependentColorsActive [REG_DWORD] = @

i Note

This registry value also has effect for Blue Crystal, Belize, Quartz and Quartz Dark Theme.

The setting can also be changed via the SAP GUI Options dialog on page | Visual Design » Color

Settings 3. The checkbox Accept default color by SAP system enables/disables the application of the color
defined by the SAP system. The SAP GUI Options dialog saves the setting under the same registry key and
value but under HKEY_CURRENT_USER. The HKEY_CURRENT_USER registry values have a higher priority
than the registry values under HKEY_LOCAL_MACHINE.

You can ignore the color defined by the SAP system for only some specific SAP systems or clients in an
SAP system. This can be achieved if one defines another color for this SAP system or client locally on the
machine like this is described in section System-Specific Color Settings (Options Dialog) [page 23] of this
guide.

8.4 Priority of the Different Color Configurations

For SAP Logon, only the locally defined default color is used as described in section SAP GUI Default Color
[page 22] of this guide.

For a SAP GUI session, several settings will be checked:

1

First of all, the locally defined color for the specific client in a specific SAP system will be checked and
applied (see section System-Specific Color Settings (Options Dialog) [page 23]).

If the client setting is not defined, the locally defined color for the specific SAP system will be checked and
applied (see section System-Specific Color Settings (Options Dialog) [page 23])

If this is also not defined and the default color defined by a SAP system is set to be accepted (otherwise
this step will be omitted), the color defined by the SAP system will be checked and applied (see section
System-Specific Color Settings (System Profile Parameter) [page 241]).

If the profile parameter is not set, the locally defined SAP GUI default color will be checked and applied
(see section SAP GUI Default Color [page 227).

If the SAP GUI default color is not defined, the SAP GUI session will be shown in the SAP GUI default color.
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9 Registry Values and Read-Only Feature of
SAP GUI Options Dialog

In this chapter, the registry values are listed which are used to customize the behavior, appearance, and
functionality of SAP GUI via the SAP GUI Options dialog.

In addition, this chapter shows how to define default values for specific SAP GUI settings and how to deactivate
some settings in the SAP GUI Options dialog. However, it does not describe the functionality behind the registry
values. For this purpose, you have to refer to the SAP GUI end user guide. For the security settings, refer to the
Security Guide. You can find all SAP GUI for Windows Guides on the corresponding product page.

i Note

For most registry values, SAP GUI will first access HKEY_CURRENT_USER and, if this registry value doesn't
exist, then HKEY_LOCAL_MACHINE will be accessed.

If under HKEY_LOCAL_MACHINE this registry value also does not exist, then the SAP GUI default value will
be applied. In this document, only exceptions to this approach will be mentioned.

Registry keys for restricting specific settings in the SAP GUI Options dialog are only located under
HKEY_LOCAL_MACHINE.

i Note

Also note that in the following registry value descriptions “” stands for 'no value' or 'empty field'.

i Note

And finally note, the registry values mentioned in this documentation are described for running the 32bit
version of SAP GUI for Windows on 64bit operating systems. When you use a 32bit operating system or a
64bit version of SAP GUI for Windows, then make sure that in case of HKEY_LOCAL_MACHINE the values

are not written in the path with WOW6432Node.

Example:

64bit operating system with 32bit version of SAP GUI for Windows:
[HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\SAP\General]

32bit operating system or 64bit operating system with 64bit version of SAP GUI for Windows:
[HKEY_LOCAL_MACHINE\SOFTWARE\SAP\General]
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9.1 Read-Only Feature of the SAP GUI Options Dialog

It is possible to restrict the usage of the SAP GUI Options dialog by setting some or all of its options read-only.
Setting the options read-only in the Ul does not change the reading priority of the registry values. When options
have been set read-only, the user can no longer change these settings via the SAP GUI Options dialog.

There are three possibilities to set options in SAP GUI Options dialog read-only.

1. Setting all options read-only
To set all options in the SAP GUI Options dialog read-only, create the following registry values:
[HKEY_LOCAL_MACHINE\SOFTWARE\SAP\General]
AllOptionsReadOnly (REG_DWORD) =1
CurRegValReadOnlyActive (REG_DWORD) =0
Result: In the title bar of the SAP GUI Options dialog, the text [read-only] will be added.

2. Setting most options read-only and exceptions changeable
To activate the feature that most options in the SAP GUI Options dialog should be read-only and only a few
exceptions should remain changeable create the following registry values:
[HKEY_LOCAL_MACHINE\SOFTWARE\SAP\General]
AllOptionsReadOnly (REG_DWORD) =1
CurRegValReadOnlyActive (REG_DWORD) = 1
Result: In the title bar of the SAP GUI Options dialog, the text [partly read-only] will be added and all options
of the SAP GUI Options dialog are read-only. You can now make some special options changeable again by
using the following approach:
1. You know the registry value name of the option, for example, SelectedTheme.

2. You know the registry key where the registry value is located, for example,
[HKEY_CURRENT_USER\Software\SAP\General\Appearance].

3. Under HKEY_LOCAL_MACHINE, you now add _ReadOnly to the registry value name, for example,
SelectedTheme_ReadOnly, and create the REG_DWORD registry value under the “same” registry key
as the original registry key. For example:
[HKEY_LOCAL_MACHINE\Software\SAP\General\Appearance]

4. Setthe _ReadOnly REG_DWORD registry value to 0, so that the option belonging to this registry
value is again changeable in the SAP GUI Options dialog, for example SelectedTheme_ReadOnly
(REG_DWORD)=0.

3. To activate the feature that most options in the SAP GUI Options dialog should remain changeable and only
a few exceptions should be read-only create the following registry values:
[HKEY_LOCAL_MACHINE\SOFTWARE\SAP\General]

AllOptionsReadOnly (REG_DWORD) =0
CurRegValReadOnlyActive (REG_DWORD) =1
Result: In the title bar of the SAP GUI Options dialog, the text “[partly read-only]” will be added and all
options of the SAP GUI Options dialog remain editable.
To make specific options read-only, proceed as follows:
1. You know the registry value name of the option, for example AnimatedFocus.

2. You know the registry key, where the registry value is located, for example,
[HKEY_CURRENT_USER\Software\SAP\General\Appearance].
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3. Under HKEY_LOCAL_MACHINE, you now add _ReadOnly to the registry value name, for example,
AnimatedFocus_ReadOnly, and create the REG_DWORD registry value under the “same” registry key
as the original registry key. For example:
[HKEY_LOCAL_MACHINE\Software\SAP\General\Appearance]

4. Setthe _ReadOnly REG_DWORD registry value to 1, so that the option belonging to this registry
value will be set read-only in the SAP GUI Options dialog, for example, AnimatedFocus_ReadOnly
(REG_DWORD) =1.

9.2 Registry Values Used in the SAP GUI Options Dialog

The following sub-chapters describe the registry values that belong to settings in the SAP GUI Options dialog.
i Note

If nothing is written about a special handling for the read-only feature, then the particular option can be
separately set read-only as described above.

i Note

Also note that in the following registry value descriptions “" stands for 'no value' or 'empty field'.

9.2.1 Theme Settings Page

= SAP GUI Options - SAP Logon X
‘ Find a setting | Visual Design
v Visual Design Theme Selection
Theme Settings
Font Settings Select Theme: | Quartz Theme v
~ Branding Activate animated focus
Branding in System [] Multi-monitor scaling awareness
v Color Settings [ ] Move main menu to 'More' button
Colors in System Show INS/OVR in system information
> Interaction Design Activate SAP Fiori features
> Accessibility & Scripting ] Show toolbar buttons with text
> Multilingual Settings
> Local Data
> Tracing
> Security
>

Front-End Print
Restore & Cleanup

System Information
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Registry Values

Select Theme
[HKEY_CURRENT_USER\Software\SAP\General\Appearance]
SelectedTheme (REG_DWORD) [Default: 2048 = Quartz Theme or 16384 = Quartz Dark Theme ]

Which of the two themes is used, depends on whether the Dark mode for applications is activated in Windows
or not.

Possible Values (Invalid Value = Quartz/Quartz Dark Themes will be used):
(0x1) (Dec=1) =SAP Signature Theme

(0x2) (Dec=2) = Signature High Contrast Black Theme
(0x20) (Dec=32) =Classic Theme

(0x40) (Dec=64) = Corbu Theme

(0x80) (Dec=128) =Blue Crystal

(0x100) (Dec=256) = Belize Theme

(0x200) (Dec=512) = Belize High Contrast Black Theme
(0x400) (Dec=1024) = Belize High Contrast White Theme
(0x800) (Dec=2048) = Quartz Theme

(0x1000) (Dec=4096) = Quartz High Contrast Black Theme
(0x2000) (Dec=8192) = Quartz High Contrast White Theme

(0x4000) (Dec=16384) = Quartz Dark Theme

Restricting entries in “Select Theme” combobox
[HKEY_LOCAL_MACHINE\SOFTWARE\SAP\General\Appearance\Themes]
SelectableThemes (REG_DWORD) [Default: @x7F] (for restricting entries in “Theme” combobox):
(0x1) (Dec=1) =SAP Signature Theme

(0x2) (Dec=2) = Signature High Contrast Black Theme

(0x20) (Dec=32) =Classic Theme

(0x40) (Dec=64) = Corbu Theme

(0x80) (Dec=128) =Blue Crystal

(0x100) (Dec=256) = Belize Theme

(0x200) (Dec=512) = Belize High Contrast Black Theme

(0x400) (Dec=1024) = Belize High Contrast White Theme

(0x800) (Dec=2048) = Quartz Theme
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(0x1000) (Dec=4096) = Quartz High Contrast Black Theme
(0x2000) (Dec=8192) = Quartz High Contrast White Theme

(0x4000) (Dec=16384) = Quartz Dark Theme

i Note
Enjoy, Tradeshow and Streamline are not supported anymore as of SAP GUI for Windows 7.60.

The values for Tradeshow and Streamline are treated as invalid entries and the default theme is used
instead. The value for Enjoy was re-used for SAP Signature High Contrast Black (Ox2). Therefore, local
settings may require an adjustment when upgrading.

Example: In order to allow the selection of Blue Crystal and Corbu Theme sum up the corresponding values

0x80 and 0x40 — @xCO or in Decimal: 64 and 128 -> 192

Please, remember to change the values in Hex format or convert the Hex values to Decimal values and then
sum up the Decimal values. In order to allow the selection of “SAP Signature Theme” and “Corbu Theme" sum
up the corresponding values @x1 and 0x40 — 0x41.

Activate animated focus (not available for Classic theme)
[HKEY_CURRENT_USER\Software\SAP\General\Appearance]

AnimatedFocus (REG_DWORD) [Default: 1]{0 = inactive; 1 = active}

Multi-monitor scaling awareness (only available for Belize and Quartz Themes)
[HKEY_CURRENT_USER\Software\SAP\General\Appearance]

MultiMonitorDpiAwareness (REG_DWORD) [Default: @] {O = inactive; 1 = active}

i Note

This function is only available as of Microsoft Windows 10 Version 1803 and corresponding Server/0OS-
Versions.

Move main menu to ,More‘ button (only available for Belize and Quartz Themes)
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

MainMenuInMoreButton (REG_DWORD) [Default: @] {0 = inactive; 1 = active}

Show INS/OVR in system information (only available for Belize and newer themes)
[HKEY_CURRENT_USER\Software\SAP\General\Appearance]

ShowINSOVR (REG_DWORD) [Default: @] {O = inactive; 1 = active}

Activate SAP Fiori features (only available for Belize and Quartz Themes)
[HKEY_CURRENT_USER\Software\SAP\General\Appearance]

ActivateFioriFeatures (REG_DWORD) [Default: 1]{0 =inactive; 1= active}
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Show toolbar buttons with text (only available for Belize and Quartz Themes)
[HKEY_CURRENT_USER\Software\SAP\General\Appearance]

FioriToolbarButtonsWithIcons (REG_DWORD) [Default: 1] {0 = inactive — this means buttons are
displayed with texts only; 1 = active — this means buttons are displayed with icons}

i Note

This option can only be used when the SAP Fiori Features are activated.

i Note

In previous releases of SAP GUI for Windows, the respective option in the SAP GUI options dialog was called
Show toolbar buttons with icons. In release 7.70, it was decided to reverse this option due to a huge demand
for buttons with icons and to change the default value of the option as well. However, since the registry
value was already in use and was intended to keep working beyond an upgrade, it was decided to keep the
name of the registry value. Therefore, the name of the option and the name of the registry value do not
match anymore.

Show shadow border (only SAP Signature and Corbu Theme)
[HKEY_CURRENT_USER\Software\SAP\General\Appearance]

ShowShadowBorder (REG_DWORD) [Default: 1]{O =inactive; 1= active }

Corbu style icons (only SAP Signature Theme)
[HKEY_CURRENT_USER\Software\SAP\General\Appearance]

CoxrbuIcon (REG_DWORD) [Default: 1]1{0 =inactive; 1 = active}

9.2.2 Font Setting Page

This dialog has undergone a major change in SAP GUI for Windows Release 8.00. However, values of older SAP
GUl versions are re-used as far as possible. There is now a basic mode and an expert mode, which can be
switched on via the option Activate expert font settings mode.
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Basic Mode

= SAP GUI Options - SAP Logon X
|Find a setting | Visual Design
“ Visual Design Font Settings

Theme Settings i : ize [%]: 100
- _IE Filter by character set: Current \/| Size [%]: -

Font Settings

" Branding Monospaced Font
Color Settings Name: [ 72 Monospace v|
> Interaction Design
> Accessibility & Scripting Proportional Font
> Multilingual Settings Name: I 72 V|
> Loca'l Data Preview
> Tracing Monospaced Proportional
> Security ‘
> SAP Logon Options
> Front-End Print [} Use expert font settings
Restore & Cleanup
System Information
OK Cancel Apply Help

i Note

In basic mode, only the scaling factor can be changed; the font names of the single charsets are preset.
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Expert Mode

[and a setting

v Visual Design
Theme Settings
Font Settings

Branding

v Color Settings
Colors in System

Interaction Design
Accessibility & Scripting
Multilingual Settings
Local Data
Tracing

Security

A R AV S VR VS

Front-End Print
Restore & Cleanup

System Information

SAP GUI Options - SAP Logon

| Visual Design

Font Settings

Current ~

Filter by charset:

Monospaced Font

Name: [ 72 Monospace v] [] Bold Size [%]:
Proportional Font
Name: [72 V] [] Bold Size [%]:
Preview
Proportional

Monospaced ‘

Activate expert font settings mode

Apply Help

Registry Values

The main path for the font settings registry values is as follows:

HKEY_CURRENT_USER\SOFTWARE\SAP\SAPGUI Front\SAP Frontend Server\FontSettings

Directly in this key, you find the registry values for the currently used character set and the setting for the

expert mode:

* CurrentCharSet (REG_DWORD) [Default: @] {0 = active; 1 =inactive}

* FontExpertMode (REG_DWORD) [Default: @] {O = basic mode; 1 = expert mode}

Character set-specific registry values

All other registry values can be found in a character set-specific subdirectory, for example the values for
the character set , Japanese (Shift-JIS)" can be found under HKEY_CURRENT_USER\ SOFTWARE\ SAP\SAPGUI
Front\SAP Frontend Server\FontSettings\128. The following table shows an overview of the

character set enumeration:

Number Character Set
0 West European (Latin-1)
128 Japanese (Shift-JIS)
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Number Character Set

129 Korean (KSC5601)

134 Simplified Chinese (GB2312)
136 Traditional Chinese (BIG5)
161 Greek (Windows 1253)

162 Turkish (Windows 1254)

163 Vietnamese (Windows 1258)
177 Hebrew (Windows 1255)

178 Arabic (Windows 1256)

186 Baltic (Windows 1257)

204 Cyrillic (Windows 1251)

222 Thai (TIS620)

238 Central European (Windows 1250)

Description of the character set-specifiy registry values

General registry values

Value Description Type Default
Font.CharSet Character set to which the settings refer. The REG_DWORD Character set
value corresponds to the character set number of number
the table above, e. g. 128 for Japanese.
Registry values for Fiori Visual Themes (as of Belize)
Value Description Type Default
Fiori3.Font.Ba- Size value in basic mode REG_DWORD [80,200] de-
sic.ScaleFactor fault: 100 (nu-
meric)
Fiori3.Font.Ex-  Size value for monospaced font in expert mode ~ REG_DWORD [80,200] de-
pert.ScaleFactor fault: 100 (nu-
meric)
Fiori3.Prop.Ex-  Size value for proportional font in expert mode ~ REG_DWORD [80,200] de-
pert.ScaleFactor fault: 100 (nu-
meric)
Fiori3.Font.Bold  Value of Bold checkbox for monospaced font REG_DWORD 0{0 =inactive; 1
= active}
Fiori3.Prop.Bold  Value of Bold checkbox for proportional font REG_DWORD 0 {0 =inactive; 1
= active}
Fiori3.Font.Face- Name of the monospaced font REG_SZ Depends on the

name

set charset

Fiori3.Prop.Face-
name

Name of the proportional font

REG_SZ Depends on the
set charset
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Registry values for older themes

Value Description Type Default
Font.Basic.Sca- Size value in basic mode REG_DWORD [80,200] de-
leFactor fault: 100 (nu-
meric)
Font.Expert.Sca- Size value for monospaced font in expert mode ~ REG_DWORD [80,200] de-
leFactor fault: 100 (nu-
meric)
Prop.Expert.Sca- Size value for proportional font in expert mode ~ REG_DWORD [80,200] de-
leFactor fault: 100 (nu-
meric)
Font.Bold Value of Bold checkbox for monospaced font REG_DWORD 0 {0 = inactive: 1
= active}
Prop.Bold Value of Bold checkbox for proportional font REG_DWORD 0 {0 =inactive; 1
= active}
Font.Facename  Name of the monospaced font REG_SZ Depends on the

set charset

Prop.Facename  Name of the proportional font REG_SZ Depends on the
set charset

Read-only Feature

As of SAP GUI for Windows 8.00, there are new registry values to deactivate all Ul elements belonging to fixed
(=monospaced) and/or proportional fonts in all themes. The main path is as follows:

HKEY_LOCAL_MACHINE\SOFTWARE\ (WOW6432Node) \SAP\SAPGUI Front\SAP Frontend
Server\FontSettings

There, you can set the fixed font, proportional font and the expert mode read-only with the following registry
values:

* tosetthe fixed font read-only set FixedFont_ReadOnly to 1
* to set the proportional font read-only set PropFont_ReadOnly to 1
* tosetthe expert checkbox read-only set FontExpertMode_ReadOnly to 1

If the fixed or proportional font is set read-only via the above registry values, then it is possible to re-activate
certain Ul elements (font name, size, bold) for certain character sets (Fiori and/or non-Fiori theme). For
example, Bold in non-Fiori themes (Belize and newer) should be again changeable for character set @ (if
CurRegValReadOnlyActive is active):

HKEY_LOCAL_MACHINE\SOFTWARE\ (WOW6432Node) \SAP\SAPGUI Front\SAP Frontend
Server\FontSettings\@

set Font.Bold_ReadOnly to @
The registry values to set Ul elements read-only have to be created under the following path:

HKEY_LOCAL_MACHINE\SOFTWARE\ (WOW6432Node) \SAP\SAPGUI Front\SAP Frontend
Server\FontSettings\ {CHARSET_NUMBER}

The values for the Ul elements are as follows:
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Value

Ul Element

Facename_ReadOnly

Font combobox

Bold_ReadOnly

Bold checkbox

Expert.ScaleFactor_ReadOnly

Size in Expert Mode

Basic.ScaleFactor_ReadOnly

Size in Basic Mode

And these values can be combined with the following prefixes:

Prefix Description

Font. for fixed font

Prop. for proportional font
Fiori3. for Fiori themes
Example

The following example deactivates the Size field in the basic mode for the Japanese character set
for Fiori themes: HKEY_LOCAL_MACHINENSOFTWARE\(WOW6432Node)\SAP\SAPGUI Front\SAP Frontend
Server\FontSettings\128\Fiori3.Font.Basic.ScaleFactor_ReadOnly =1

9.2.3 Branding Page

SAP GUI Options - Y13 X

[and a setting

| Visual Design

v Visual Design
Theme Settings
Font Settings

~ Branding

Default Branding

Activate branding in titlebar of SAP GUI sessions

Default Branding Image to Display:

v Color Settings

Interaction Design

Local Data

Traces

Security

AV A " A R v

Front End Print
Restore & Clean-up

System Information

Branding in System

Colors in System

Accessibility & Scripting
Multilanguage Settings

IC:\Program Files (x86)\SAP\FrontEnd\SAPGUI\Branding\Branding\SAPiL]{ Select }

Preview:

“ Cancel Apply Help
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Registry Values
Activate Branding

[HKEY_CURRENT_USER\Software\SAP\General\Appearance]

UseBrandingImage (REG_DWORD) [Default: @] {0 = inactive; 1= active}

Path to default branding image
[HKEY_CURRENT_USER\Software\SAP\General\Appearance]

BrandingImage (REG_SZ) [Default: “"] {valid path to a valid image file}

By default, this page is read-only. To set this page changeable, create the following registry values (it is not
necessary to activate the read-only feature for setting this page changeable):

[HKEY_CURRENT_USER\Software\SAP\General\Appearance]
UseBrandingImage_ReadOnly (REG_DWORD) =0
BrandingImage_ReadOnly (REG_DWORD) =0

You find more information on branding in section Using Default Branding [page 16] in this guide.

9.2.4 Branding in System

= SAP GUI Options - YI3 X
[ Find a setting I Visual Design
~ Visual Design Branding setting and Preview for system YI3
Theme Settings Default configuration

Font Settings
SAP_Logo.png

~ Branding
Branding in System Y13\Logol.png
~ Color Settings YI3\Logo2.png

<> I < >

Colors in System
VI2\ naAn2 nna

Interaction Design Titlebar
Accessibility & Scripting

Multilanguage Settings Branding Setting and Preview for system YI3 client 000

AV VY V" AR VR vy

Local Data A
Traces System setting “
Security SAP_Logo.png I
Front End Print Yia\Logol.png

Restore & Clean-up

. Y13\L 2.
System Information ogoz.png

<>

A A

Titlebar

o
4

“ Cancel Apply Help ‘
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Filling the System/Client List Box

The system list box contains all the entries from the branding root folder and all the entries from the folder with
the system ID of the current system. The list box reflects the folder structure from the branding root folder. For
more information on the branding root folder, see Using System/Client-specific Branding [page 17].

The client list box contains all entries from the system list box and (if available) the content of the client folder
(within the system folder) for the current system and the current client.

Read-Only Feature

The Branding in System page is by default read-only, even if the read-only feature is not activated.
However, administrators can activate the page for their users via the corresponding registry values:

[HKEY_LOCAL_MACHINE\SOFTWARE\SAP\General\Appearance\Systems] (64-Bit SAP GUI or
32bit operating system)

[HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\SAP\General\Appearance\Systems] (32-Bit
SAP GUI on a 64bit operating system)

BrandingSystemSpecific_ReadOnly (REG_DWORD) {Default: 1}

Error Display

Errors are displayed directly in the list box (for example: 'File configured in the registry was not found in branding
root folder") or as hint in the information area (for example: 'Branding root folder does not contain any pictures").
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9.2.5 Define Custom Colors (SAP Signature)

SAP GUI Options - SAP Logon -

Search:
* [£= Visual Design | Define Custom SAP Signature Colors
* [2 Theme Settings T —
* [3 Font Settings gig g"ld e o ey
: Branding reen S
— - SAP Purple —
o Define Custom Colors, SAP Red = — :
5 Color Settings SAP Signature Default = - '_‘.':f_' P ————

* [0 Interaction Design
» 7 Accessibility & Scripting =
* 3 Multiingual Settings

* [ Local Data l Save As... I Hue shift value [Dearees]:
* [ Traces =
» [ Security l Delete I | -135| D

» [OsaAp Logon Options
» [0 Front End Print

: Restore & Cleanup Colors defined by SAP and your administrator cannot be deleted and
0 System Information overwritten

l [0]4 H Cancel ‘ ‘ Apply H Help

i Note

This dialog is only available when having chosen SAP Signature Theme.

Registry Values

Define Custom SAP Signature Colors
[HKEY_CURRENT_USER\Software\SAP\General\Appearance\Customer Colors\Custom Color 1]

Hue (REG_DWORD) [Default: no default = value must exist] {[@;360]: add 180 to the value which you see in
the Options Dialog e.g.: -20 — calculated decimal value for Hue registry value 160 }

Registry key name Custom Color 1 isthe name of the color, which can be selected as SAP Signature Color
on the pages Color Settings/Colors in Systems. Names for custom SAP Signature colors are freely selectable
with the exception of color names which are already defined by SAP. The Options dialog prevents the creation
of such values (if you create the registry key/value on your own, make sure your provide correct names for the
color and correct values for the hue shift value).

If the Hue registry value does not exist, then it will not be listed in the Options dialog and has no effect. If a value
is bigger than 360, it will be set to 360 (180 in the Options dialog).

If there is a registry key under HKLM, HKCU is not checked anymore and this entry cannot be changed or
deleted anymore in the Options dialog. This is also the case for the colors predefined by SAP.
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i Note
Special handling for read-only feature:

Itis only possible to set the complete page read-only/not changeable by creating the following registry
value:

[HKEY_LOCAL_MACHINE\Software\SAP\General\Appearance\Customer Coloxrs]
CustomColors_ReadOnly (REG_DWORD)

The value has to be setto 1.

9.2.6 Color Settings Page

This section describes the Color Settings Page for the following SAP GUI themes: SAP Signature, Blue Crystal,
Belize, Quartz and Quartz Dark.

9.2.6.1 Color Settings for Signature Theme

SAP GUI Options - SAP Logon x

Search:

* [ Visual Design | SAP Theme Default Color

0 Theme Settings SAP Gold

. Font Settings SAP Green

+ [2] Branding g:E E::jple

& Delﬁne Customn Colors e Lk

. Color Settings
» [ Interaction Design
* [ Accessibility & Scripting
+ [0 Muttiingual Settings
* [ Local Data -
» B3 Traces |+| Accept default color defined by SAP system

(| Security

+ [ SAP Internal

» [sap Logon Options
* [ Front End Print

g Restore & Cleanup
v System Information

0K H Cancel I ‘ Apply H Help
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Registry Values

SAP Theme Default Color

[HKEY_CURRENT_USER\Software\SAP\General\Appearance]

SignatureDefaultColor (REG_SZ) [Default: “"]

Possible values:
SAP Gold
SAP Green
SAP Purple
SAP Red

SAP Signature Default;in case of an empty string, missing registry value, or unvalid value, the SAP

Signature default is used.

Accept default color defined by SAP systems
[HKEY_CURRENT_USER\Software\SAP\General\Appearance]

SignatureSystemDependentColorsActive (REG_DWORD) [Default: 1]1{0 = inactive; 1 = active}

9.26.2 Color Settings for Blue Crystal Theme

O isual Design
= 2] Theme Settings
Font Settings
= [2) Branding
= [2] color Settings
Interaction Design

Accessibility & Scripting
Multilingual Settings

Local Data

Traces

Security

SAP Internal

hd SAP Logon Options
Gereral

. Local Configuration Files
Server Configuration Files
> Front End Print

= [2] Restore & Cleanup

= [B System Information

WOWOW W N

Search:

SAP Therme Default Color

SAP BC Gold
SAR BC Green
SAP BC Purple
SAP BC Red

< sccept default color defined by SAP system

Change takes effect for new sessions and after restart of SAP Logon (Pad),

i,

| oK | | Canicel | |

Anply || Help
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Registry Values

SAP Theme Default Color
[HKEY_CURRENT_USER\Software\SAP\General\Appearance]

BlueCrystalDefaultColor (REG_SZ) [Default: “"]

Possible values:
SAP BC Gold
SAP BC Green
SAP BC Purple
SAP BC Red

Blue Crystal;in case of an empty string, missing registry value, or unvalid value, the BlueCrystal Theme is
used.

Accept default color defined by SAP systems

[HKEY_CURRENT_USER\Software\SAP\General\Appearance]

SignatureSystemDependentColorsActive (REG_DWORD) [Default: 1]1{0 = inactive; 1 = active}
i Note

This registry value also has effect for Blue Crystal Theme, Belize Theme and Quartz Theme.
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9.2.6.3 Color Settings for Belize

= SAP GUI Options - SAP Logon

Find a setting Visual Design
v Visual Design SAP Theme Default Color
Theme Setings
Font Settings Belize Gold
i Belize Green
. Branding B} Belize Purple
_ Color Settings Belize Red
> Interaction Design
> Accessibility & Scripting
> Multilingual Settings )
v| Accept default color defined by SAP system
> Local Data
> Traces
> Security
> SAP Logon Options
> Front End Print

Restore & Cleanup
System Information

OK Cancel Help

Registry Values

SAP Theme Default Color
[HKEY_CURRENT_USER\Software\SAP\General\Appearance]

BelizeDefaultColor (REG_SZ) [Default: “"]

Possible values:
Belize Gold
Belize Green
Belize Purple
Belize Red

Belize; in case of an empty string, missing registry value, or unvalid value, the Belize is used.

Accept default color defined by SAP systems
[HKEY_CURRENT_USER\Software\SAP\General\Appearance]

SignatureSystemDependentColorsActive (REG_DWORD) [Default: 1]1{0 = inactive; 1 = active}
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i Note

This registry value also has effect for Blue Crystal Theme, Belize Theme and Quartz Theme.

9.2.6.4 Color Settings for Quartz

= SAP GUI Options - SAP Logon X
| Find a setting | Visual Design
~ Visual Design SAP Theme Default Color
Theme Settings Quartz
Font Settings Quartz Gold
. Quartz Green
. Branding ) Quartz Purple
_ Color Settings. Quartz Red
> Interaction Design
> Accessibility & Scripting
> Multilingual Settings i
Accept default color defined by SAP system
> Local Data
> Traces
> Security
v SAP Logon Options
General

Configuration Files
> Front End Print
Restore & Cleanup
System Information

Registry Values

SAP Theme Default Color
[HKEY_CURRENT_USER\Software\SAP\General\Appearance]

QuartzDefaultColor (REG_SZ) [Default: *"]

Possible values:

Quartz Gold
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Quartz Green
Quartz Purple
Quartz Red

Quartz; in case of an empty string, missing registry value, or unvalid value, the Quartz is used.

Accept default color defined by SAP systems

[HKEY_CURRENT_USER\Software\SAP\General\Appearance]

SignatureSystemDependentColorsActive (REG_DWORD) [Default: 1] {0 = inactive; 1 = active}

i Note

This registry value also has effect for Blue Crystal Theme, Belize and Quartz Theme.

9.2.6.5 Color Settings for Quartz Dark

Registry Values

SAP Theme Default Color

[HKEY_CURRENT_USER\Software\SAP\General\Appearance]

QuartzDarkDefaultColox (REG_SZ) [Default: “"]

Possible values:
Quartz Dark Gold
Quartz Dark Green
Quartz Dark Purple
Quartz Dark Red

Quartz Dark; in case of an empty string, missing registry value, or unvalid value, the Quartz is used.

Accept default color defined by SAP systems
[HKEY_CURRENT_USER\Software\SAP\General\Appearance]

SignatureSystemDependentColoxrsActive (REG_DWORD) [Default: 1]{0 =inactive; 1= active}

i Note

This registry value also has effect for Blue Crystal, Belize and Quartz/Quartz Dark themes.
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9.2.7 Colors in System Page

This section describes the Colors in System Page for the following SAP GUI themes: SAP Signature, Blue
Crystal, Belize and Quartz. This page is only displayed when the SAP GUI options dialog is started from a SAP

GUI session and the client-specific settings are only available when you are logged on (and thus the client is
determined).

9.2.71 Colors in System Page for Signature Theme

SAP GUI Cptions
Search: !
~ 5 Visual Design | Colar Setting for SAP System
* [2] Theme Settings Default configuration Aem kA —
+ [2] Font Settings SAP Gold
B Brandin S&P Green
. 9 SAP Purple
- Define Customn Colors SAaP Red <
* [2) Color Settings SAP Signature Default e ——
. Colors in Systemn T S5 e
* [ Interaction Design
v [ Accessibiity & Scripting !
» [ mMultiingual Settings
v [ Local Data | Color Settings for SAP System Client 000
¥ [0 Traces 5

L cattin = —

v [0 Sacurity SaP Gal
» [0 58P Internal S&P Green
q SAP Purple __
* (3 Front End Print 4P R
* |=] Restare & Cleanup SAP Signature Default

* [B] System Information e e—riseee s

oK H Caricel ‘ | Apply H Heln

Registry Values

Color Setting for SAP system SID

[HKEY_CURRENT_USER\Software\SAP\General\Appearance\Systems\SID]

ThemeName (REG_SZ) [Default: registry key and registry value do not exist] {SID in the registry key is your
SAP System ID}
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Possible values:

Value does not exist or is empty — Default configuration or SAP system configuration
SAP Gold

SAP Green

SAP Purple

SAP Red

SAP Signature Default

Color Settings for SAP system SID client <number>
(only possible in SAP Signature Theme and if the SAP system supports this feature)
[HKEY_CURRENT_USER\Software\SAP\General\Appearance\Systems\SID\000]

ThemeName (REG_SZ) [Default: registry key and registry value do not exist] {SID in the registry key is your
SAP System ID and <number> is the current client in the SAP system, for example 000}

Possible values: the same like for “Color Setting for SAP system SID"

You find more information for system/client-dependent color theming in section Setting SAP Signature Theme
Color.

i Note
Special handling for read-only feature:

Itis only possible to set the complete page read-only/not changeable by creating the following registry
value:

[HKEY_LOCAL_MACHINE\Software\SAP\General\Appearance\Systems]
ColorsSystemSpecific_ReadOnly (REG_DWORD)

The value has to be set to 1.
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9.2.7.2 Colors in System Page for Blue Crystal Theme

Sap GUT Options
Search:

v ¥ visual Design Color Setting for SAP System

* [2) Theme Settings Default configuration . Cemgae | Gaoenmes

. ) BlueCrystal

= [2] Font Settings SAP BC Gold :

* [& Branding 58P BC Green : =

~ [2) Color Settings gig EE Ezrdple i

*[31 Colors in System e ——
> Interaction Design
> Accessibiity & Scripting
» Multilingual Settings
> P Local Data Calar Settings for SAP System Client 000
> Traces System setting .
) BlueCrystal

7 [ Security 54 BC Gold
> [Im 54P Internal S8P BC Green
> [0 Frant End Print AP BC Purple .

: S&P BC Red =
- [B1 Restore & Ceanup e = =
= [2 Swstem Information

oK | | Cancel | | Bpply | | Help

Registry Values

Color Setting for SAP system SID
[HKEY_CURRENT_USER\Software\SAP\General\Appearance\Systems\SID]

ThemeNameBC (REG_SZ) [Default: registry key and registry value do not exist] {SID in the registry key is your
SAP System ID}

Possible values:

Value does not exist or is empty = Default configuration or SAP system configuration
SAP BC Gold

SAP BC Green

SAP BC Purple

SAP BC Red

Blue Crystal
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Color Settings for SAP system SID client <number>
(only possible if the SAP system supports this feature)
[HKEY_CURRENT_USER\Software\SAP\General\Appearance\Systems\SID\000]

ThemeNameBC (REG_SZ) [Default: registry key and registry value do not exist] {SID in the registry key is your
SAP System ID and <number> is the current client in the SAP system, for example 000}

Possible values: the same like for Color Setting for SAP system SID
i Note
Special handling for read-only feature:

Itis only possible to set the complete page read-only/not changeable by creating the following registry
value:

[HKEY_LOCAL_MACHINE\Software\SAP\General\Appearance\Systems]
ColorsSystemSpecific_ReadOnly (REG_DWORD)

The value has to be set to 1.

9.2.7.3 Colors in System Page for Belize Theme

= SAP GUI Options b4
~ Wisual Design Calor Setting for SAP System
Theme Settings Default configuration e —
) Belize == -
Font Settings Belize Gold = —
Branding Belize Green
~ Color Settings g:t:;: E:lrdpte

Colors in System

Interaction Design

Accessibility & Scripting . .
Color Settings for SAP System Client 000

Multilingual Settings

(System setting L
Local Data S -
Traces Belize Gold
Security Belize Green

Belize Purple
SAP Internal Belize Red

Front End Print

R L R

Restore & Cleanup

System Information

oK Cancel Help
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Registry Values

Color Setting for SAP system SID
[HKEY_CURRENT_USER\Software\SAP\General\Appearance\Systems\SID]

ThemeNameBelize (REG_SZ) [Default: registry key and registry value do not exist] {SID in the registry key is
your SAP System ID}

Possible values:

Value does not exist or is empty — Default configuration (Belize) or SAP system configuration is used

Belize Gold

Belize Green

Belize Purple

Belize Red

Belize

Color Settings for SAP system SID client <number>
(only possible if the SAP system supports this feature)
[HKEY_CURRENT_USER\Software\SAP\General\Appearance\Systems\SID\000]

ThemeNameBelize (REG_SZ) [Default: registry key and registry value do not exist] {SID in the registry key is
your SAP System ID and <number> is the current client in the SAP system, for example 000}

Possible values: the same like for Color Setting for SAP system SID

i Note
Special handling for read-only feature:

Itis only possible to set the complete page read-only/not changeable by creating the following registry
value:

[HKEY_LOCAL_MACHINE\Software\SAP\General\Appearance\Systems]
ColorsSystemSpecific_ReadOnly (REG_DWORD)

The value has to be set to 1.
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9.2.74 Colors in System Page for Quartz Theme

= SAP GUI Options - Y13 X
| Find a setting | Visual Design
~ Visual Design Color Setting for SAP System Y13
Theme Settings Default configuration e
Font Settings Quartz
) Quartz Gold g - S
Branding Quartz Green
~ Color Settings Quartz Purple
o . a Quartz Red
. Colors in System
> Interaction Design
> Accessibility & Scripting
> Multilingual Settings Color Settings for SAP System YI3; Client 000
> Local Data I
Quartz
’ Tracefs Quartz Gold = - —
> Security Quartz Green
; Quartz Purple
> Front End Print Quartz Red ‘
Restore & Cleanup
System Information

Registry Values

Color Setting for SAP system SID
[HKEY_CURRENT_USER\Software\SAP\General\Appearance\Systems\SID]

ThemeNameQuaxtz (REG_SZ) [Default: registry key and registry value do not exist] {SID in the registry key is
your SAP System ID}

Possible values:

Value does not exist or is empty = Default configuration (Quartz) or SAP system configuration is used

Quartz Gold

Quartz Green

Quartz Purple

Quartz Red

Quartz

Color Settings for SAP system SID client <number>

(only possible if the SAP system supports this feature)
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[HKEY_CURRENT_USER\Software\SAP\General\Appearance\Systems\SID\000]

ThemeNameQuartz (REG_SZ) [Default: registry key and registry value do not exist] {SID in the registry key is
your SAP System ID and <number> is the current client in the SAP system, for example 000}

Possible values: the same like for Color Setting for SAP system SID

i Note
Special handling for read-only feature:

Itis only possible to set the complete page read-only/not changeable by creating the following registry
value:

[HKEY_LOCAL_MACHINE\Software\SAP\General\Appearance\Systems]
ColorsSystemSpecific_ReadOnly (REG_DWORD)

The value has to be setto 1.

9.2.7.5 Colors in System Page for Quartz Dark Theme

Color Setting for SAP system SID

[HKEY_CURRENT_USER\Software\SAP\General\Appearance\Systems\SID]

ThemeNameQuartzDark (REG_SZ) [Default: registry key and registry value do not exist] {SID in the registry
key is your SAP System ID}

Possible values:

Value does not exist or is empty = Default configuration (Quartz Dark) or SAP system configuration is used
Quartz Dark Gold

Quartz Dark Green

Quartz Dark Purple

Quartz Dark Red

Quartz Dark

Color Settings for SAP system SID client <number>

(only possible if the SAP system supports this feature)
[HKEY_CURRENT_USER\Software\SAP\General\Appearance\Systems\SID\000]

ThemeNameQuaxtz (REG_SZ) [Default: registry key and registry value do not exist] {SID in the registry key is
your SAP System ID and <number> is the current client in the SAP system, for example 000}

Possible values: the same like for Color Setting for SAP system SID
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i Note

Special handling for read-only feature:

Itis only possible to set the complete page read-only/not changeable by creating the following registry

value:

[HKEY_LOCAL_MACHINE\Software\SAP\General\Appearance\Systems]

ColorsSystemSpecific_ReadOnly (REG_DWORD)

The value has to be setto 1.

9.2.8 Classic Design - Options Page

'L SAP GUI Options - SAP Logon

Theme: Classic Theme ~
| — |9 visual Design Window
Theme Preview/Settings

Font Seftings Standard Tookar
h Applicaton Toolbar

Color in Forms
+| O3 Interaction Design
+I (3 Accessibiity & Scripting
+| 03 Multiingual Settings
+|O Local Data
+|O Traces
+ 3 Security
+| 3 sSAP Internal
1+ SAP Logon Options
+| 3 Front: End Print

System Information

Status Bar

0K Cancel Apphy Help
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SAP R/2 Classic Style
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Registry Values

Standard Toolbar
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]
Toolbar (REG_DWORD) [Default: 1]1{0 = inactive; 1 = active}

Application Toolbar
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

Buttonbar (REG_DWORD) [Default: 1]{O = inactive; 1 = active}

Status Bar
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]
Statusbar (REG_DWORD) [Default: 1]{O = inactive; 1 = active}

Standard Application Toolbar
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

Toolbar.RegulaxrButtons (REG_DWORD) [Default: @] {O = inactive; 1 = active}
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9.2.9 Classic Design - Color in Lists Page

'L SAP GUI Options - SAP Logon

Theme: Classic Theme ~ Search:

| — |29 visual Design

Theme Preview/Settings Mormal Intensive Inverse
Font Seftings ® Color 1 T Color 1 " Color 1
" Color 2 (" Color 2 " Color 2
+| O3 Interaction Design " Color 3 " Celor 3 C
+I 3 Accessibiity & Scripting
+| O Multingual Settings " Color 4 " Color 4 " Color 4
+|J Local Data
+|O Traces " Celor 5 T Celor 5 " Color 5
I3 Security
+ ISP Internal T Color &  Coors C Color 6
+|C3 5P Logon Options
FC3 Front End Print " Color 7 I Color 7 " Color 7
System Information
T— Defalt @ Background Color

() Text Color
[Use list colors also in high contrast mode
[ show list background in SAP R./3 Classic style

Ok Cancel Apphy Help Restore Defaults
Registry Values
Normal

[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Palette]

* Background Color
NormalColox1l (REG_SZ) [Default: 255 128 128]{RGB value} till
NormalColox7 (REG_SZ) [Default: 227 199 235]{RGB value}

* Text Color
NormalTextl (REG_SZ) [Default:@ @ 0]{RGB value} till
NormalText7 (REG_SZ) [Default:®@ @ 0] {RGB value}

Intensive

[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Palette]
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* Background Color
IntensiveColor1l (REG_SZ) [Default: 125 166 207]{RGB value} till
IntensiveColoxr7 (REG_SZ) [Default: 196 150 207]{RGB value}

* Text Color
IntensiveTextl (REG_SZ) [Default:@ @ 0] {RGB value} till
IntensiveText7 (REG_SZ) [Default:@ @ 0] {RGB value}

Inverse

[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Palette]
* Background Color

InverseColorl (REG_SZ) [Default:192 192 192]{RGB value} till

InverseColox7 (REG_SZ) [Default: 192 192 192]{RGB value}
¢ Text Color

InverseTextl (REG_SZ) [Default:@ @ 255]{RGB value} till

InverseText7 (REG_SZ) [Default: 204 @ 204]{RGB value}
Use list colors also in high contrast mode
[HKEY_CURRENT_USER\Software\SAP\General\Appearance]

UseListColoxSetting (REG_DWORD) [Default: 1]{0 =inactive; 1 = active}

Show list background in SAP R/ 3 Classic style
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]
ColorScheme (REG_DWORD) [Default: @]{0 = inactive; 1 = active}
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9.2.10 Classic Design - Color in Forms Page

'L SAP GUI Options - SAP Logon

Theme: Classic Theme ~ Search:
| —| S8 visual Design Colors
Therme Preview/Settings
Font Settings Color Palettes
gcp;lg??ns Lists Standard b Copy to Custom
T 03 Interaction Design Field Colors
10 Accessbility & Scripting Main Window - Background v
+| O Muldingual Settings
+ O Local Data
+|3 Traces
+I03 Security Change

+H O SaP Internal
1+ S4P Logon Options
+| 3 Front End Print Others

System Information
3D Effects

oK Cancel Apply Help Restore Defallts

Registry Values

Color Palettes
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Palette]
Palette (REG_DWORD) [Default: @]

Possible values: 1-12

Field Colors

[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Palette]
Edit.BgndBrush (REG_SZ) [Default: 255 255 255]{RGB value}

Edit.FocusBrush (REG_SZ) [Default: 255 255 255]{RGB value}

Edit.TextNorm (REG_SZ) [Default:®@ 0 0}
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Edit.TextInt (REG_SZ) [Default: 255 @ 0}

Read.BgndBrush (REG_SZ) [Default: system defined value for “Face color for three-dimensional display
elements and for dialog box backgrounds”] {RGB value}

Read.FocusBrush (REG_SZ) [Default: same value as Read.BgndBrush] {RGB value}
Read.TextNoxrm (REG_SZ) [Default:® @ @]{RGB value}

Read.TextInt (REG_SZ) [Default:®@ @ 255]{RGB value}

Static.TextNorm (REG_SZ) [Default:®@ @ 0] {RGB value}

Static.TextInt (REG_SZ) [Default:@ @ 255]{RGB value}

Frame.BgndBrush (REG_SZ) [Default: same value as Read.BgndBrush] {RGB value}

View.BgndBrush (REG_SZ) [Default: same value as Read.BgndBxush] {RGB value}

3D Effects
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

Shadow (REG_DWORD) [Default: 1]

ListEffect (REG_DWORD) [Default: 1]

9.2.11 Applications Page

= SAP GUI Options X

‘ Find a setting | Visual Design

~ Visual Design Expert Option
Theme Settings = SapGuiServer
Font Settings
Branding
Color Settings
Applications

Interaction Design

Accessibility & Scripting

Multilingual Settings

Local Data

Traces

Security [ Add J [ Remove J
SAP Logon Options

Front End Print

Restore & Cleanup

R R N N YA VARV RV

System Information

Enable SAP GUI visual theme for listed applications that support this
m feature (for example: host application for SAP GUI Scripting Engine).
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i Note

This page is only displayed, when the Options dialog is started from the Control Panel or the Start menu
and when not using Classic Theme.

Registry Values

Application name in list
[HKEY_CURRENT_USER\Software\SAP\General\Applications\<application>], for example:
[HKEY_CURRENT_USER\Software\SAP\General\Applications\cscript]

In this example, cscript is the application name of cscript.exe.

Enable SAP GUI visual theme (checked/unchecked state)
[HKEY_CURRENT_USER\Software\SAP\General\Applications\cscript]

Enjoy (REG_SZ) [Default: On] {Off = inactive; On = active}

i Note
Special handling for read-only feature:
To set the whole page read-only/not changeable, create the following registry value:

[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\SAP\General\Applications] (32bit SAP GUI for
Windows on a 64bit operating system)

[HKEY_LOCAL_MACHINE\SOFTWARE\SAP\General\Applications]

AppsSapGuiVisualTheme_ReadOnly

The value has to be set to 1.

SAP GUI Administration
Registry Values and Read-Only Feature of SAP GUI Options Dialog PUBLIC 59



9.2.12 Keyboard Settings Page

= SAP GUI Options - SAP Logon X
| Find a setting ' Interaction Design
> Visual Design Keyboard Settings

~ Interaction Design i
[[] Activate accelerator keys

Keyboard Settings . o . .

- — Access keys offer quick focus navigation by holding down [Shift+Ctrl+Alt] and
Visualization 1 pressing the required character keys. Note: This option does not work with
Visualization 2 languages with non-Latin characters.

Notifications [v] Automatically move focus to next input field on reaching the end of input field
Control Settings

i [v] Remember cursor position within input fields

Sound Settings
> Accessibility & Scripting [v] Position cursor at the end of the value when entering a field
> Multilingual Settings [ Automatically select complete value when entering a field in insert mode (INS)
2 Local Data [ 1 Automatically move mouse cursor to focused element (for magnifier tools)
> Tracing - 4
> Security LIZ Block selection (CTRL + Y) with TAB separated content B
> SAP Logon Options
> Front-End Print

Restore & Cleanup
System Information

Registry Values

Activate access keys
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

UseClientAccesskeys (REG_DWORD) [Default: AccMode enabled — 1 otherwise @] {O = inactive; 1 = active}

Automatically move focus to next input field
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

AutoTAB (REG_DWORD) [Default: @] {0 = inactive; 1 = active}

Remember cursor position within input fields
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

PositionTAB (REG_DWORD) [Default: 1] {0 =inactive; 1 = active}

Position cursor at the end of value when entering a field

[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]
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PositionMouse (REG_DWORD) [Default: 1]{0 =inactive;1 = active}

Automatically select complete value

[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

Edit.EnterFieldSelectAll (REG_DWORD) [Default: 1]{0 =inactive;1 = active}

Automatically move mouse cursor to focused element

[HKEY_CURRENT_USER\Software\SAP\General\Applications]

MouseFollowFocus (REG_DWORD) [Default: @] {0 = inactive; 1 = active}

Block Selection (CTRL + Y) with TAB separated content
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

CopyAndPasteTabSeparated (REG_DWORD) [Default: @] {O = inactive; 1 = active}

9.2.13 Visualization 1 Page

‘ Find a setting

>

hv

Visual Design
Interaction Design

Keyboard Settings
f_ Visualization 1_t

{ v v v v

Visualization 2
Notifications
Control Settings
Sound Settings

Accessibility & Scripting

Multilingual Settings

Local Data

Traces

Security

SAP Logon Options
General
Configuration Files

Front End Print

Restore & Cleanup

System Information

SAP GUI Options - SAP Logon

Interaction Design
Cursor Width for Input Fields on Screens

(®) Narrow cursor (O Wide cursor
[C] Use block cursor in overwrite mode (OVR)

Controls
[] Show keys within dropdown lists
[ Sort by keys within dropdown lists for most efficient keyboard input
OK Code

Show OK Code field
Show dialog box for OK Code in batch input

Lists

Use cursor within lists

Show lines in lists

[] Underline links in lists

Allow Microsoft ClearType to be used for text in lists
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Registry Values

Cursor Width for Input Fields on Screens
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

Edit.CaretWidth (REG_DWORD) [Default: 2] {1 = narrow; 2 = wide}

Use block cursor in overwrite mode (OVR)
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

Edit.BlockCursor (REG_DWORD) [Default: @] {0 =inactive; 1= active}

Show keys within dropdown lists
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

Dropdown.ShowKey (REG_DWORD) [Default: @] {O = inactive; 1 = active}

Sort by keys within dropdown lists
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

Dropdown.SortKey (REG_DWORD) [Default: @] {0 =inactive; 1= active}

i Note

This option can only be activated, if also Show keys within dropdown lists is activated.

Show OK Code field
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

HideCmdLinePermanently (REG_DWORD) [Default: @]{O; 1}

Show dialog box for OK code in batch input
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

PopupBatchIn (REG_DWORD) [Default: 1]{0 = inactive; 1 = active}

Use cursor within lists
HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

ListCursoxr (REG_DWORD) [Default: 1]{0 = inactive; 1 = active}

Show lines in lists
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

ListLines (REG_DWORD) [Default: 1]{O =inactive; 1 = active}
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Underline links in lists
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

UnderlineHotspot (REG_DWORD) [Default: @] {O = inactive; 1 = active}

Allow Microsoft ClearType to be used for texts in lists
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

ListAllowClearType (REG_DWORD) [Default: 1]1{0 = inactive;1 = active}

9.2.14 Visualization 2 Page

= SAP GUI Options - SAP Logon X
| Find a setting | Interaction Design
> Visual Design Window Title
v Interaction Design [] Show system name in taskbar button
Keyboard Settings
Visualization 1 Ellipsis
r . . . 1
_ Visualization 2 [v] Show ellipsis (..) if text cannot be displayed entirely
Notifications
Control Settings Enhanced Search
Sound Settings (e) Show Enhanced Search automatically
> Accessibility & Scripting () Show Enhanced Search on demand using shortcut (Ctrl+Shift+Q)
> Multilingual Settings () Do not show Enhanced Search
> Local Data
> Traces Password Field
> Security [v] Show placeholder characters
> SAP Logon Options
> Front End Print

Restore & Cleanup
System Information

Registry Values

Show system name in taskbar button
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Administration]

ShowAdditionalTitleInfo (REG_DWORD) [Default: @]{0 = inactive; 1= active}
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Ellipsis

[HKEY_CURRENT_USER\Software\SAP\General\Appearance]

EllipsisFoxrI18n (REG_DWORD) [Default: 1]{0 = inactive; 1= active}

Enhanced Search

[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

EnhancedSearchMode (REG_DWORD) [Default: 1] {0 = do not show; 1 = show automatically; 2 = show on
demand}

Show placeholder characters

[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

PasswordPlaceholderChars (REG_DWORD) [Default: 1]{0 = password field is not completely filled with
placeholder characters; 1 = password field is completely filled with placeholder characters}

9.2.15 Notifications Page

= SAP GUI Options - SAP Logon X
| Find a setting | Interaction Design
> Visual Design Tooltip
» Interaction Design Tooltip Delay [Medium (0.5 seconds) “
Keyboard Settings .
. o [ Show tooltip on focus change
Visualization 1
Visualization 2 .
r a essages
. Notifications g
Control Settings [ Beep at message
Sound Settings [] Show success messages in a dialog box
> Accessibility & Scripting [] Show warning messages in a dialog box
7 Multilingual Settings [] Show error messages in a dialog box
> Local Data
> Traces
> Security
> SAP Logon Options
> Front End Print
Restore & Cleanup
System Information
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Registry Values

Tooltip delay
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

BubbleDelay (REG_DWORD) [Default: 1]{0 = quick; 1 = medium; 2 = slow; 3 = none}

Show tooltip on focus change
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

BubbleOnTab (REG_DWORD) [Default: @] {0 = inactive; 1 = active}

Beep at message
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

BeepError (REG_DWORD) [Default: @]{O =inactive; 1= active}

Show success messages in a dialog box
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

PopupSuccess (REG_DWORD) [Default: @] {O = inactive; 1 = active}

Show warning messages in a dialog box
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

PopuplWarning (REG_DWORD) [Default: @] {O = inactive; 1 = active}

Show error messages in a dialog box
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

PopupError (REG_DWORD) [Default: @] {O = inactive; 1 = active}
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9.2.16 Control Settings Page

= SAP GUI Options - SAP Logon x
| Find a setting | Interaction Design
> Visual Design Additional Control Services

~ Interaction Design
Keyboard Settings

[] Enable additional control services

Search Provider: |Google ~

Visualization 1

Visualization 2
Notifications HTML Control

Control Settings Browser Control: :_Edge (based on Chromium) -
Sound Settings Internet Explorer
. L. Edge (based on Chromium)
Accessibility & Scripting
Multilingual Settings

Local Data

Traces

Security

SAP Logon Options
Front End Print
Restore & Cleanup

A Y " R R R "

System Information

Registry Values

Enable additional control sevices
[HKEY_CURRENT_USER\Software\SAP\General]

SAPGUIControlPlugin (REG_DWORD) [Default: @] {O = inactive; 1= active }

Search Provider
[HKEY_CURRENT_USER\Software\SAP\General\ControlServices\WebSearchEngine]

WebSearchEngine (REG_SZ) [Default: Google]{AltaVista, Google, MSN, Yahoo}

Customizeable docking container position

i Note

Not available for Belize and Quartz Themes.

[HKEY_CURRENT_USER\Software\SAP\General]

SAPDockAllowMoveSave (REG_DWORD) [Default: @] {0 =inactive; 1= active}
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Browser Control

[HKEY_CURRENT_USER\Software\SAP\General]

BrowserControl (REG_DWORD) [Default: 1]{0 = Internet Explorer; 1 = Edge (based on Chromium)}

i Note

As of SAP GUI for Windows 8.00 the default value for this setting was changed to 1 so that the Edge (based
on Chromium) version of the HTML Control is used.

i Note

Value 1 (Edge (based on Chromium)) is only available when the Microsoft WebView2 control is available on
the client PC. The WebView?2 control can be obtained from Microsoft and can be distributed and updated
via the regular Microsoft distribution tools. See https://developer.microsoft.com/en-us/microsoft-edge/

webview2/ # for more information.

9.2.17 Sound Settings Page

[ Find a setting

SAP GUI Options - SAP Logon

| Interaction Design

> Visual Design Sound Feedback
v Interaction Design ] Activate sound feedback
Keyboard Settings
Y & Sound Scheme SAP Percussion
Visualization 1
Visualization 2 Messages
Notifications Success E] I Success-Msg.wav l Browse
Control Settings .
r 4 sett & Warning: E] I Warning-Msg.wav l Browse
Sound Settings
= = Error-Msg.wav
> Accessibility & Scripting Error E] I g l Browse
> Multilingual Settings
> LocalD Other Events
ocal Data
Checkbox/radio button CheckBox.wav
> Tracing E]I I Browse
> Security Open dialog box E] I DialogBox.wav l Browse
> SAP Logon Options Expand/collapse tree E] I Expand.wav I Browse
> Front-End Print Choose pushbutton E] I PushButton.wav I Browse
Restore & Cleanup
Switch tab/page TabStrip.wav
System Information pag E] l > l Browse
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Registry Values

Activate sound feedback
[HKEY_CURRENT_USER\Software\SAP\General\Appearance]

Sound (REG_SZ) [Default: off; in accessibility mode: On] {Off = inactive; On = active }

Libraries
[HKEY_CURRENT_USER\Software\SAP\General\Appearance]

SoundLibrary (REG_DWORD) [Default: @ - SAP Ethno]

Success
[HKEY_CURRENT_USER\Software\SAP\General\Appearance]

SND_MESSAGE_SUCCESS (REG_EXPAND_SZ) [Default: undefined; this means that the respective sound from
the standard library is used] {Contains the path and file name of the .wav file to be played. An empty value
means no sound is played.}

Warning

[HKEY_CURRENT_USER\Software\SAP\General\Appearance]

SND_MESSAGE_WARNING (REG_EXPAND_SZ) [Default: undefined; this means that the respective sound from
the standard library is used] {Contains the path and file name of the .wav file to be played. An empty value
means no sound is played.}

Error

[HKEY_CURRENT_USER\Software\SAP\General\Appearance]

SND_MESSAGE_ERROR (REG_EXPAND_SZ) [Default: undefined; this means that the respective sound from the
standard library is used] {Contains the path and file name of the .wav file to be played. An empty value means
no sound is played.}

Checkbox/Radiobutton select

[HKEY_CURRENT_USER\Software\SAP\General\Appearance]

SND_CHECKBOX_RADIOBUTTON_CLICK (REG_EXPAND_SZ) [Default: undefined; this means that the
respective sound from the standard library is used] {Contains the path and file name of the .wav file to be
played. An empty value means no sound is played.}

Dialog Box open

[HKEY_CURRENT_USER\Software\SAP\General\Appearance]

SND_DIALOGBOX_OPEN (REG_EXPAND_SZ) [Default: undefined; this means that the respective sound from
the standard library is used] {Contains the path and file name of the .wav file to be played. An empty value
means no sound is played.}

Expand/Collapse tree

[HKEY_CURRENT_USER\Software\SAP\General\Appearance]
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SND_TREE_EXPAND_COLLAPSE (REG_EXPAND_SZ) [Default: undefined; this means that the respective sound
from the standard library is used] {Contains the path and file name of the .wav file to be played. An empty value
means no sound is played.}

Pushbutton press

[HKEY_CURRENT_USER\Software\SAP\General\Appearance]

SND_PUSHBUTTON_CLICK (REG_EXPAND_SZ) [Default: undefined; this means that the respective sound from
the standard library is used] {Contains the path and file name of the .wav file to be played. An empty value
means no sound is played.}

Tab/Page switch

[HKEY_CURRENT_USER\Software\SAP\General\Appearance]

SND_TABCONTROL_CLICK (REG_EXPAND_SZ) [Default: undefined; this means that the respective sound from
the standard library is used] {Contains the path and file name of the .wav file to be played. An empty value
means no sound is played.}

9.2.18 Accessibility Page

= SAP GUI Options - SAP Logon X
| Find a setting | Accessibility & Scripting
> Visual Design Accessibility Settings

> Interaction Design

v Accessibility & Scripting
f_ Accessibility_t

Scripting

Multilingual Settings
Local Data Desktop Office Integration

Traces

Security

SAP Logon Qptions

Front End Print

Restore & Cleanup

[T] Use accessibility mode

Include read-only and disabled elements in tab chain

Display symbols in lists as letters

[] Open Office documents outplace for better screen reader support

NOONON NV VW

System Information

i Note

The Accessibility mode is not available for the Corbu and Blue Crystal Themes.
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Registry Values

Use accessibility mode
[HKEY_CURRENT_USER\Software\SAP\General]

AccMode (REG_SZ) [Default: 0ff] {Off = inactive; On = active }

i Note

This option has to be activated to be able to activate the other options on this page.

Include read-only and disabled elements in tab chain
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Accessibility]

EnhancedTabChain (REG_DWORD) [Default: 1]{0 = inactive; 1 = active }

Display symbols in lists as letters
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Accessibility]

SymbolsAsLetters (REG_DWORD) [Default: 1]{0 =inactive; 1= active }

Open Office documents outplace for better screen reader support
[HKEY_CURRENT_USER\Software\SAP\General]

OfficeOutplaceMode (REG_SZ) [Default: of f]{"on" =active, “off" = inactive}

9.2.19 Scripting Page

= SAP GUI Options - SAP Logon X
| Find a setting | Accessibility & Scripting
> Visual Design Installation
> Interaction Design ‘ Scripting is installed
~ Accessibility & Scripting
. Accessib_illity User Settings
_ Scripting, Enable scripting
> Multilingual Settings — ) N SAP GUI
> Local Data Notify when a script attaches to
S Traces Notify when a script opens a connection
> Security [] Show native Microsoft Windows dialogs
> SAP Logon Options
> Front End Print
Restore & Cleanup
System Information
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Registry Values

i Note

If SAP GUI Scripting is not installed, you see the corresponding message Scripting is not installed in the
Installation field. If this is the case, the options below cannot be set. For more information on SAP GUI
Scripting, see the SAP GUI Scripting Security Guide.

Enable Scripting
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Security]

UserScripting (REG_ DWORD) [Default: 1]{O = inactive; 1 = active}

i Note

This option has to be activated to be able to activate the options mentioned below.

Notify when a script attaches to SAP GUI
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Security]

WarnOnAttach (REG_DWORD) [Default: 1]{0 = inactive; 1 = active}

Notify when a script opens a connection
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Security]

WarnOnConnection (REG_DWORD) [Default: 1]{0 = inactive; 1 = active}

i Note

The notification options can only be set via HKCU to leave the decision to the user, if he or she wants to
really deactivate the notification in case of script starts.

Show native MS Windows dialogs
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Scripting]
ShowNativeWinDlgs (REG_DWORD) [Default: @] {O =inactive; 1 = active}

For more information on this feature, see SAP note 1974590 #& .
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9.2.20 IME Page

= SAP GUI Options - SAP Logon X
| Find a setting | Multilingual Settings
> Visual Design Multibyte Input
> Interaction Design [] Continuous input on two lines
> Accessibility & Scripting
~  Multilingual Settings Close IME Automatically
r 1
_IME, [] On numeric or right-justified fields
Encoding o I
Graphic [] On one-byte fields
Others ! . 1off
5 Local Data Alternative IME On/Off Key
> Traces ® Shift + Space
> Security O cCul + Space
> SAP Logon Options O None
> Front End Print
Restore & Cleanup
System Information
Registry Values

Continuous input on two lines
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

KanjiContInpu (REG_ DWORD) [Default: @] {O = inactive; 1 = active }

Close IME on numeric or right-justified fields
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

ImeCloseRJustify (REG_DWORD) [Default: @] {O =inactive; 1= active}

Close IME on one-byte fields
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

ImeCloseOneByte (REG_DWORD) [Default: @]{O =inactive; 1= active }

Alternative IME on/off key
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

KanjiKey (REG_DWORD) [Default: @]{0 = Shift + Space; 1 = Ctrl + Space; 2 = None }
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9.2.21 Encoding Page

= SAP GUI Options - SAP Logon

| Find a setting | Multilingual Settings

Visual Design Text Encoding

Interaction Design [[] Auto-detect Latin1 characters
Accessibility & Scripting

v v v

Multilingual Settings Keyboard Layout
IME

- A [ Adjust font to input language
. Encoding

Graphic SAP Code Page
Others

Local Data Adjust font to SAP code page at logon
Traces

Security

SAP Logon Options
Front End Print

Restore & Cleanup

WVOOWON NN

System Information

Registry Values

Auto-detect Latinl characters

[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

LatinlAutoDetect (REG_ DWORD) [Default: @] {O = inactive; 1 = active }

Adjust font to the input language

[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

AdjustFontToKL (REG_DWORD) [Default: @] {O = inactive; 1= active }

Adjust font to SAP code page at logon

[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

AdjustFontToSapCP (REG_DWORD) [Default: 1] {0 = inactive; 1 = active }
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9.2.22 Graphic Page

= SAP GUI Options - SAP Logon X
| Find a setting | Multilingual Settings
> Visual Design Text Font
> Interaction Design [ User setting
> Accessibility & Scriptin
. v i pting Small: | | Select
v Multilingual Settings
IME Medium: | | Select
Encoding
r - Large: | | Select
. Graphic
Others Local Texts
> Local Data i
Always use this language:
> Traces
> Securi .
v . PostScript Font
> SAP Logon Options
S Front End Print Font File to Load (Environment Variable PSFONTFILE)
Restore & Cleanup ‘ | [ Browse... ] [ Clear J
System Information Font Name (Environment Variable PSFONTNAME)

| |[ Change ][ Clear J

For this page, no values are stored in the registry, but in the SAP Graphics configuration file and environment
variables.

i Note
Special handling for read-only feature:
To set the whole page read-only/not changeable, create the following registry value:

[HKEY_LOCAL_MACHINE\SOFTWARE \Wow6432Node\SAP\SAPGUI Front\SAP Frontend
Server\Customize] (32bit SAP GUI for Windows on a 64bit operating system)

[HKEY_LOCAL_MACHINE\SOFTWARE\SAP\SAPGUI Front\SAP Frontend Server\Customize]

GraphicsSettings_ReadOnly

The value has to be set to 1.
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9.2.23 Others Page

= SAP GUI Options - SAP Logon

| Find a setting | Multilingual Settings
> Visual Design Shortcut Key
> Interaction Design [[] Hide shortcut key for multibyte menu
> Accessibility & Scripting
v Multilingual Settings Function Code
IME [0 De not send function code when IME is open
Encoding
Graphic System Parameters
r A
UTER Menu Font: ‘ Segoe Ul, 9 |
> Local Data —
> Traces Title Font: ‘ Segoe Ul, 9 |
> Security
> SAP Logon Options Local Texts
> Front End Print [T Use language setting of SAP Logon
Restore & Cleanup
System Information RTL/LTR Layout
Set layout in accordance with logon language
Registry Values

Hide shortcut key for multibyte menu
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

KanjiHideShoxtcut (REG_DWORD) [Default: @] {O = inactive; 1 = active }

Do not send function code when IME is open

[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

KanjiSuppressPFKey (REG_DWORD) [Default: @] {O = inactive; 1 = active }

System parameters

= Windows system parameters

Use SAP Logon language setting
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

UseSaplogonLang (REG_DWORD) [Default: @] {O = inactive; 1 = active }
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RTL/LTR Layout - Set layout in accordance with the logon language
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

BidirectOnLang (REG_DWORD) [Default: 1]{O = inactive; 1 = active }

9.2.24 History Page

= SAP GUI Options - SAP Logon X
‘HWaSHMQ | Local Data
> Visual Design History Status
> Interaction Design O off ® On O Immediately
> Accessibility & Scripting
> Muliilingual Settings History Settings
~ Local Data
.r Historyjl Expiry Time [Month(s)]:
Cache
Maximum Permitted File Size [MB]: 10
File Lifetime IMB] - =
Local Tab Order Maximum Number of Entries:
> Traces
> Security Enable History for Fields Up To [Characters]:
> SAP Logon Options
> Front End Print [ Clear History ]
Restore & Cleanup
System Information Directory for Input History:
| CaUsers\d03\AppDatalRoaming\SAP\SAP GUNHistory |
Registry Values
History Status

[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\LocalData]

ShowMode (REG_ DWORD) [Default: 1] {0 = Off; 1 = on; 2 = Immediately }

Expiry Time
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\LocalData]

Expiration (REG_DWORD) [Default: 3]{0 -1000}

Maximum Permitted Files Size

[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\lLocalData]
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FileSize (REG_DWORD) [Default: 1] {O - 200}

Maximum Number of Entries
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\lLocalData]

NoEntries (REG_DWORD) [Default: 20]{1- 99}

Enable History for Fields up to [character]
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\LocalData]

FieldLenHistoryOn (REG_DWORD) [Default: 59]{1 - 255}

Directory for Input History
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\LocalData]

DataPath (REG_SZ) [Default: %AppData%\Roaming\SAP\SAP GUI\Histoxry]{valid path with write
permission}

A\ Caution

Different registry key/value under HKLM, which can be set via installation (for further information see
Installation Guide):

[HKEY_LOCAL_MACHINE\SOFTWARE\SAP\SAP Shared]

SAPhistorydir (REG_EXPAND_SZ)

9.2.25 Cache Page

= SAP GUI Options - SAP Logon X
‘ Find a setting | Local Data
> Visual Design Local Cache
Interaction Desi . . ~
2 eracllo.rf ESIgn_ . Maximum Cache Size [MB]:
> Accessibility & Scripting —
> Multilingual Settings Maximum Cache File Size [KB]: 5120 |5
v Local Data
History Directory for Local Cache Data:
r =
— | CaUsers\d03\AppDatalLocal\SAP\SAP GUN\Cache |
File Lifetime
Local Tab Order [ Delete Local Cache Files ]
> Traces
> Security
> SAP Logon Options
> Front End Print

Restore & Cleanup
System Information
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Registry Values

Maximum Cache Size

[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\LocalData]

MaxCacheSize (REG_ DWORD) [Default: 50] {O — 10000 MB}

iNote
Saved in Bytes not MB; default in Bytes: 52428800.

Maximum Cache File Size

[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\LocalData]

MaxCacheFileSize (REG_DWORD) [Default: 5120]{0 - 10000 KB}

i Note
Saved in Bytes not KB; default in Bytes: 52428800.

If you have adjusted your local settings for these parameters, the change of the default values will not have any
impact on you.

Additionally, if you are updating your SAP GUI installation, the change will also not have any impact, because
up to patchlevel 3 of SAP GUI for Windows 7.50 the SAP GUI Installation wrote the old default settings

into the Windows registry. Therefore, in case of an update, you either have to remove the registry values
MaxCacheSize and MaxCacheFileSize under HKLM\Software\SAP\SAPGUI Front\SAP Frontend
Server\LocalData or define sensible values via the SAP GUI Options dialog (these settings are persisted
under HKCU).

For more information on the default settings, see note 2565360#% (Adjusted default settings for client file
cache in SAP GUI for Windows).
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9.2.26 File Lifetime Page

= SAP GUI Options - SAP Logon

‘ Find a setting ‘ Local Data
> Visual Design Deletion of Files and Subfolders in Documents Folder
> Interaction Design "(i) Never
I .. [
» Accessibility & Scripting () Always during SAP Logon (Pad) shutdown
> Multilingual Settings () File lifetime (date modified) [daysl: B
» Local Data Directory for Documents:
History
\ C:\Users\D0O3\Documents\SAP\SAP GUI
Cache
File Lifetime { Open Documents Folder
Local Tab Order
> Tracing Deletion of Files in Traces Folder
> Security () Never
> SAP Logon Options () Always during SAP Logon (Pad) shutdown
> Front-End Print () File lifetime (date created) [days]: ‘ 1
Restore & Cleanup Directory for Traces:

System Information \ C:\Users\DO3\AppData\Local\SAP\SAP GU\Traces\

{ Open Traces Folder }

Deletion of Files from Chromium Edge Browser Control

{ Clear Browser Control Cache }

Registry Values

Deletion of Files in Documents Folder

[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\LocalData]
DeleteDocuments (REG_ DWORD) [Default: 0]

DocumentLifetime (REG_ DWORD) [Default: ]

* Never (DeleteDocuments = @ and DocumentLifetime = 0)
* Always during SAP Logon (Pad) shutdown (DeleteDocuments =1 and DocumentLifetime = 0)
* File lifetime (DeleteDocuments = 1 and DocumentLifetime ={1 - 30})
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i Note

Special handling for read-only feature:

Setting most options changeable and only some exceptions read-only:

Itis enough to set one of the two registry values read-only, so that the radio buttons will be disabled.
Setting most options read-only and exceptions changeable:

For both registry values a corresponding *_ReadOnly REG_DWORD registry value must be created and set
to @, so that the radio buttons will be enabled.

Deletion of Files in Traces Folder

[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\LocalData]
DeleteTraces (REG_DWORD) [Default: 1]

TraceLifetime (REG_ DWORD) [Default: 1]

* Never (DeleteTraces =0 and TraceLifetime = 0)
¢ Always during SAP Logon (Pad) shutdown (DeleteTraces =1and TraceLifetime =0)
* Filelifetime (DeleteTraces =1and TraceLifetime={1 - 30})

i Note

Special handling for read-only feature:

Setting most options changeable and only some exceptions read-only:

It is enough to set one of the two registry values read-only, so that the radio buttons will be disabled.
Setting most options read-only and exceptions changeable:

For both registry values a corresponding *_ReadOnly REG_DWORD registry value must be created and set
to @, so that the radio buttons will be enabled.

Deletion of Files from Chromium Edge Browser Control

None of the buttons on this page support the read-only feature, because the user data folders can contain
personal data, which the user must be able to access or delete.
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9.2.27 Local Tab Order Page

= SAP GUI Options - SAP Logon X

‘ Find a setting | Local Data

Visual Design Local Tab Order

Interaction Design Directory for Local Tab Order Database:

>
b
> Accessibility & Scripting | CaUsers\d03\AppDatalRoaming\SAP\SAP GUNLocalTabOrder |
>
N

Multilingual Settings
Local Data [ Clear Local Tab Order J

History

Cache

File Lifetime

Local Tab Order
Traces
Security
SAP Logon Options
Front End Print
Restore & Cleanup

NOONON N

System Information

Registry Values

Directory for local tab order database
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\LocalData]

LocalTabOxrdexrPath (REG_EXPAND_SZ) [Default: %APPDATA%\SAP\SAP GUI\LocalTabOrdexr]{valid
path with write permission}

i Note

Special handling for read-only feature:

To enable/disable the button Clear local tab order, create the following registry value:
[HKEY_LOCAL_MACHINE\SOFTWARE\SAP\SAPGUI Front\SAP Frontend Server\lLocalData]

ClearLocalTabOrder_ReadOnly

The value has to be set to 1.
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9.2.28 Session Traces Page

= SAP GUI Options - SAP Logon X
‘ Find a setting | Traces
> Visual Design Session Trace
Interaction Design :
’ lon besign Abap Editor ~ [ Time stamps
> Accessibility & Scripting Access Control
> Multilingual Settings Qg\éagrcisd Tree Control I [J Memory
> Local Data Automation [ Detailed output
 Traces Border Painter Control -
- - Calendar
Session Traces Context Manager
' : Control Manager
SAP GUITraces Crystal Container
SAP Logon Traces Eliag Parser -
Security . Select All J [ Deselect All ]
> SAP Logon Options
> Front End Print Display Options

Restore & Cleanup [ Show window

System Information . .
[] View on disable

Trace Folder: | C:\Users\d03\AppData\Local\SAP\SAP GUNTraces\

[ Enable J [ Delete All Trace Files ] [ Open Trace Folder]

m Trace(s) are enabled/disabled in all new sessions.

This page is only needed for error analysis and the creation of traces will only be triggered by SAP support
employees.

i Note
Special handling for read-only feature:
To set the whole page read-only/not changeable create the following registry value:

[HKEY_LOCAL_MACHINE\SOFTWARE \Wow6432Node\SAP\SAPGUI Front\SAP Frontend
Server\Trace] (32bit SAP GUI for Windows on a 64bit operating system)

[HKEY_LOCAL_MACHINE\SOFTWARE\SAP\SAPGUI Front\SAP Frontend Server\Trace]

SessionTrace_ReadOnly

The value has to be set to 1.
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9.2.29 SAP GUI Traces Page

= SAP GUI Options - SAP Logon X
‘ Find a setting | Traces

Visual Design SAP GUI Trace

Interaction Design @ Trace deactivated

Accessibility & Scripting
Multilingual Settings

(O Level 1: Errors
() Level 2: Errors and Warnings
() Level 3: All (Diagnostic Trace)

>
>
>
>
> Local Data
~

Traces

Session Traces
" SAP GUI Traces,
SAP Logon Traces
Security
> SAP Logon Options
> Front End Print
Restore & Cleanup

[ Delete All Trace Files J [ Open Trace Folder J

System Information

This page is only needed for error analysis and creating traces will be only triggered by SAP support employees.

i Note
Special handling for read-only feature:
To set the radio buttons read-only/not changeable create the following registry value:

[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\SAP\SAPGUI\Trace] (32bit SAP GUI for Windows
on a 64bit operating system)

[HKEY_LOCAL_MACHINE\SOFTWARE\SAP\SAPGUI\Trace]

Level_ReadOnly

The value has to be set to 1.
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9.2.30 SAP Logon Traces Page

= SAP GUI Options - SAP Logon X
‘ Find a setting | Traces

> Visual Design SAP Logon Trace

> Interaction Design @® Trace deactivated

> Accessibility & Scripting O Errors

> Multilingual Settings O Errors and warnings

> Local Data . .

() Errors, warnings, and monitor
~  Traces

. Errors, warnings, monitor, and detailed output
Session Traces O g P

SAP GUI Traces
Ir SAP Logon Tracesjl
Security
> SAP Logon Options
> Front End Print
Restore & Cleanup
System Information

() Errors, warnings, monitor, detailed output, and time stamp

[ Delete All Trace Files J [ Open Trace Folder ]

This page is only needed for error analysis and creating traces will be only triggered by SAP support employees.

i Note
Special handling for read-only feature:
To set the radio buttons read-only/not changeable create the following registry value:

[HKEY_LOCAL_MACHINE\SOFTWARE \Wow6432Node\SAP\SAPLogon\Options] (32bit SAP GUI for
Windows on a 64bit operating system)

[HKEY_LOCAL_MACHINE\SOFTWARE\SAP\SAPLogon\Options]

SapLogonTraceLevel_ReadOnly

The value has to be set to 1.
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9.2.31 Security Settings Page

‘ Find a setting

>
>
>
>
>
>
~

Visual Design
Interaction Design
Accessibility & Scripting
Multilingual Settings
Local Data

Traces

Security

Security Configuration

SAP Logon Options
Front End Print

Restore & Cleanup
System Information

SAP GUI Options - SAP Logon

Security
Security Module
Status: Disabled
Disabled
[ Open Security Configuration } Customized
Strict Deny
Security Rule Status
Default Action: Ask
SAP Rules: 458
Administrator Rules (TotaUDisabled): | 27610
User Rules (Total/Disabled): | 8/0

v

Help

How to disable and set security settings is described in the Security Guide.

i Note

Special handling for read-only feature:

To disable/enable editing, creating, deleting, and changing of the priority of user rules, create the following

registry value:

[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\SAP\SAPGUI Front\SAP Frontend

Server\Security] (32bit SAP GUI for Windows on a 64bit operating system)

[HKEY_LOCAL_MACHINE\SOFTWARE\SAP\SAPGUI Front\SAP Frontend Server\Security]

UserRuleEditing_ReadOnly

The value has to be set to 1.
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9.2.32 SAP Logon Options - General Page

= SAP GUI Options - SAP Logon X
|Find a setting | SAP Logon Options

> Visual Design SAP Logon Options

> Interaction Design Language: EN

> Accessibility & Scripting

Use SAP Logon language as default on logon screen

> Multilingual Settings

> Local Data Message Server Timeout in Seconds 10 { Use Default

> Tracing Confirm deletion of entries

> Security | | Disable editing of connection entries

~ SAP Logon Options

[ ] On closing the SAP Logon (Pad), hide it from task bar
General

Configuration Files
> Front-End Print

SAP GUI Start Options

Restore & Cleanup Additional Command Line Arguments:

System Information

Registry Values

Language
[HKEY_CURRENT_USER\Software\SAP\General]

Language (REG_ SZ) [Default: 0S default language]{two characters language shortcut: see the
dropdown box in SAP GUI Options dialog}

Use SAP Logon language as default language on logon screen

[HKEY_CURRENT_USER\Software\SAP\SAPLogon\Options]
UseSAPLogonLanguageAsDefault (REG_ DWORD) [Default: 1]{ O =inactive; 1 = active}

You find more information on this feature under Setting Logon Language [page 21].

Message Server Timeout
[HKEY_CURRENT_USER\Software\SAP\SAPLogon\Options]

MessageServexrTimeout (REG_DWORD) [Default: 10]

Confirm deletion of connection entries

[HKEY_CURRENT_USER\Software\SAP\SAPLogon\Options]
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ConfirmDelete (REG_DWORD) [Default: 1] {0 = inactive; 1 = active}

Disable editing of connection entries
[HKEY_CURRENT_USER\Software\SAP\SAPLogon\Options]

NoEditFunctionality (REG_DWORD) [Default: @]{O =inactive; 1= active}

On closing the SAP Logon (Pad), hide it from task bar
[HKEY_CURRENT_USER\Software\SAP\SAPLogon\Options]

HideToTrayBaxr (REG_DWORD) [Default: @] {O =inactive; 1 = active}

SAP GUI Start Options — Additional Command Line Arguments
[HKEY_CURRENT_USER\Software\SAP\SAPLogon\Options]

SapguiNTCmdOpts (REG_SZ) [Default: ""]{valid SAP GUI command line argument(s)}

i Note
The reading priority for these registry values is as follows:

* SAP Logon: HKCU — HKLM
* SAP Logon Pad: HKLM — HKCU

For “Language” take into account that the default value (in case both registry values under HKCU and
HKLM are not defined) is the operating system language. For Use SAP Logon language as default language
on logon screen and Hide SAP Logon (Pad) to tray bar the reading sequence was changed in SAP GUI for
Windows 7.70 patchlevel 2. As of this patch, these values take the reading priority HKCU -> HKLM and they
are active by default even in SAP Logon Pad. If you want to make these options inactive, use the read-only
feature for these options, see also Read-Only Feature of the SAP GUI Options Dialog [page 27].
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9.2.33 SAP Logon Options - Configuration Files Page

= SAP GUI Options - SAP Logon X
| Find a setting | SAP Logon Options
> Visual Design Configuration Files
> Interaction Design Path to local configuration files:
> Accessibility & Scripting ‘ C:Users\d03\AppData\Roaming\SAP\Common | Select
> Multilingual Settings XML Configuration File on Server:
> Local Data ‘ |
> Traces
> Security Configuration File Caching
~ SAP Logon Options Allow caching of remote configuration files
General (®) Update cache on every SAP Logon (Pad) start
r . . . i
, Configuration Files () Update cache only in an interval of [hours]:
2 Front End Print Path: | C:\Users\d03\AppData\Roaming\SAP\LogonServerConfigCache |
Restore & Cleanup
System Information Loaded Files
Type Path

Local File CAUsers\d03\AppDataiRoaming\SAP\CommonmSAPUILandscape xml

Registry Values

Path to Local Configuration Files
[HKEY_CURRENT_USER\Software\SAP\SAPLogon\Options]

PathConfigFilesLocal (REG_EXPAND_ SZ) [Default: %APPDATA%\SAP\Common] {valid path with write
access}

i Note
The reading priority for these registry values are as follows:

* SAP Logon: HKCU — HKLM
* SAP Logon Pad: HKLM — HKCU

XML Configuration File on Server

Depending on the configuration of your landscape, different file paths are displayed here, if they are not
overwritten by the user:

[HKEY_CURRENT_USER\Software\SAP\SAPLogon\Options]
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LandscapeFileOnServer (REG_EXPAND_ SZ) [Default: ""]{valid path to the correct configured XML-File}

Or if you have created a core configuration file that can be supplied and set only by an administrator and not by
the users:

[HKEY_LOCAL_MACHINE\SOFTWARE\SAP\SAPLogon\Options] (64bit SAP GUI for Windows or 32bit
operating system)

[HKEY_LOCAL_MACHINE\SOFTWARE \Wow6432Node\SAP\SAPLogon\Options] (32bit SAP GUI for Windows
on a 64bit operating system)

CoreLandscapeFileOnServer (REG_EXPAND_SZ) [Default: “"]

For more information on the configuration with SAP Ul Landscape, see the SAP GUI for Windows Installation
Guide, section Configuration Information.

Allow caching of remote configuration files
[HKEY_CURRENT_USER\Software\SAP\SAPLogon\Options]

AllowCachingSexrverConfigFiles (REG_DWORD) [Default: 1]{0 =inactive; 1= active}

i Note

The term remote configuration files refers to the server (“central™) SAP Ul Landscape file as well as to the
core configuration file and files specified by command line parameter or environment variable, but located
on a remote server.

Update cache...
[HKEY_CURRENT_USER\Software\SAP\SAPLogon\Options]

LandscapeCacheExpiryPeriod (REG_DWORD) [Default: @] {O = update on every SAP Logon (Pad) start;
[60, 599940] = interval in minutes}

You find more information on the caching features in the SAP GUI Frontend Installation Guide in section
"Caching Remote Configuration Files".

i Note
Note the reading priority for these registry values:

* SAP Logon: HKCU — HKLM
* SAP Logon Pad: HKLM — HKCU

Loaded Configuration Files

In this list box, type and path of the loaded server files are displayed.

Type Description

Local File This is the SAP Ul Landscape file containing user specific en-
tries located inthe Path to local configuration
files folder.
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Type

Description

Server file

This file type is displayed in two cases and shows the file

listed under XML Configuration File on Server:

* CorelLandscapeFileOnServer und
LandscapeFileOnServer are set; in this case
LandscapeFileOnServer overrules the other set-
ting

* onlyLandscapeFileOnServerisset

General File

Only CoreLandscapeFileOnServer, but not
LandscapeFileOnServer is set.

Include File

An SAP Ul Landscape file may contain include statements
pointing to further SAP Ul Landscape files. A file referenced
by such an include statement is listed with this type.

Please, note that only the first level of included files is listed,
this means that a file included by an included file is not listed
here.

Command Line Parameter

SAP Logon (Pad) can be started with command line param-

eter /LSXML_FILE. Inthis case, the SAP Ul Landscape
file provided as parameter to this call is listed here with type

Command Line Parameter.

Environment Variable

SAP Logon (Pad) evaluates the environment variable

SAPLOGON_LSXML_FILE which determines the location
of the SAP Ul Landscape file to be used. In this case, the SAP
Ul Landscape file provided via environment variable is listed

here with type Environment Variable.

i Note

By double-clicking the configuration file entries in the listbox, you can display their content in the

associated application for displaying XML files.
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9.2.34 Frontend Print Settings Page

= SAP GUI Options - SAP Logon X

| Find a setting | Front End Print

Visual Design Front End Print
Interaction Design
Accessibility & Scripting [
Multilingual Settings

Local Data

Configure Front End Print J

Traces

Security

SAP Logon Options
Front End Print

r L1
_ Front End Print
Restore & Cleanup
System Information

R N N N R RV RV v

To configure front end printing, choose Configure Front End Print. This leads you to the print options editor. You
find more information in the print options help or in 1149136 # .

i Note

The Configure Front End Print button is read-only by default. To view the frontend print options, you have to
activate this button via the keys listed below. Note that to do this, you have to switch to another mode of
the read-only feature (see Read-Only Feature of the SAP GUI Options Dialog [page 27]):

[HKEY_LOCAL_MACHINE\Software\SAP\General\Appearance]

FrontEndPrint_ReadOnly (REG_DWORD)
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9.2.35 Restore & Clean Up Page

= SAP GUI Options - SAP Logon X
‘ Find a setting |
> Visual Design Restore & Cleanup
> Interaction Design [] Restore SAP GUI default settings
> Accessibility & Scriptin
L. Yy . piing [[] Delete all user-defined security rules
> Multilingual Settings
S Local Data [] Clear input history
> Traces [] Delete local cache files
> Security [T] Clear local tab order
> SAP Logon Options o
. [[] Delete all files in document folder
> Front End Print
:— Restore & Cleanup—: [[] Delete all files in temp folder
System Information [[] Delete all files in trace folder

[] Clear Chromium Edge browser control cache

Restore and Cleanup

Migrate Configuration & Settings

( — ) T )

Restoring the default settings and clearing the local tab order take effect
after restarting the SAP Logon Pad.Close all SAP GUI sessions and SAP
Logon Pad after applying these changes.

The (de)activation of the items on the Restore & Cleanup page requires special handling for the read-only
feature:

Setting AllOptionsReadOnly deactivates only the checkboxes Restore SAP GUI default settings, Delete all user-
defined security rules and Clear local tab order. The other checkboxes and the button Restore and Cleanup
cannot be disabled at all, because the user must be able to delete the respective files/settings, because they
might contain person-related data.

The same situation can be achieved by using the following registry value:
[HKEY_LOCAL_MACHINE\SOFTWARE\SAP\General\Appearance]
RestoreDefaults_ReadOnly [Default: 0]

You can explicitly disable Clear local tab order using the following registry value:
[HKEY_LOCAL_MACHINE\SOFTWARE\SAP\General\Appearance]
ClearLocalTabOrder_ReadOnly [Default: 0]

The database for the local tab order does not contain any person-related data and the administrator may wish
to prevent the deletion of a local tab order database that has been deployed together with SAP GUI.

SAP GUI Administration
92 PUBLIC Registry Values and Read-Only Feature of SAP GUI Options Dialog



Furthermore, you can disable Delete all user-defined security rules by setting the following registry value:
[HKEY_LOCAL_MACHINE\SOFTWARE\SAP\SAPGUI Front\SAP Frontend Server\Security]
DeleteAllUserDefinedSecurityRules_ReadOnly [Default: @]

The user-defined security rules also do not contain any person related data.

To disable the Import and Export buttons use the following registry keys:
[HKEY_LOCAL_MACHINE\SOFTWARE\SAP\General\Appearance]
ImportConfigurationAndSettings_ReadOnly [Default: @]

ExportConfigurationAndSettings_ReadOnly [Default: 0]

Last but not least, you can enable or disable Restore SAP GUI default settings by setting the following registry

value:
[HKEY_LOCAL_MACHINE\SOFTWARE\SAP\General\Appearance\]

RestoreSAPGUIDefaultSettings_ReadOnly [Default: 0]

9.2.36 System Information Page

= SAP GUI Options - SAP Logon

‘ Find a setting ‘

> Visual Design System Information
» Interaction Design Release: [ 800 Final Release - 64bit
> Accessibility & Scripting
> Multilingual Settings pililane: ’ saplogon.exe
> Local Data File Version: [8000.1.0.1161
= s
> SAP Logon Options Patch Level: [ 0
> Front-End Print
Restore & Cleanup
IrSystem Information-r Installation Check

Check SAP GUI Installation }

You can disable the Check SAP GUI Installation button using the read-only feature.
To achieve this, use the following registry value:
[HKEY_LOCAL_MACHINE\SOFTWARE\SAP\General\Appearance]

InstallationCheck_ReadOnly [Default: 0]
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10 Registry Values of SAP GUI in General

10.1 Registry Values of SAP GUI for Windows 32bit and
64bit Versions

As of SAP GUI for Windows 8.00, SAP GUI for Windows is shipped as a 32bit version as well as a new 64bit
version. In previous releases, only the 32bit version was available.

When using registry values for configuring SAP GUI for Windows, you need to be aware of the following:

* Most user settings (for example those written by changes done via the SAP GUI Options dialog) are
persisted in the Windows registry under HKEY_CURRENT_USER. These values are used by both the 32bit
version and the 64bit version of SAP GUI for Windows.

* Administrator settings (for example created by an installation package) are stored in the Windows registry
under HKEY_LOCAL_MACHINE. A 32bit SAP GUI for Windows accesses the HKEY_LOCAL_MACHINE
branch of Windows registry under the path HKEY_LOCAL_MACHINE\Software\Wow6432Node\SAF..,
whereas a 64bit SAP GUI for Windows accesses the HKEY_LOCAL_MACHINE branch of the Windows
registry under the path HKEY_LOCAL_MACHINE\Software\SAP..

This means:
* User settings are shared between 32bit and 64bit SAP GUI for Windows versions
* Administrator settings for 32bit and 64bit SAP GUI for Windows versions may be different on the same
client PC (even though this will hardly be desired).
When deploying SAP GUI for Windows along with administrative settings, you need to be aware to
which path of the Windows registry to write.
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10.2 Displaying OK Code Field and Status Bar Info

= User System Help

SAP
1) hd ‘ More Exit
Client: || Information -
_ _ Development System I
User: ‘
Main Clients:
000 Development / Pl Integration Server
Logon Language: @ 100 Customizing R
., .. s — Y
Enter a valid SAP user or choose one from the list @
Registry Values

1- OK field opened
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]
HideCmdLinePermanently (REG_DWORD) [Default: @]

{0 = OKCode field opened; 1 = OKCode field closed}

2 - Display Status Bar Info
[HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

Statusbar.Layout (REG_DWORD) [Default: 1]

{0 =inactive; 1 = active}
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10.3 Disabling Input History via Registry

You have the possibility to completely disable the input history via registry. The history database will not be
created in this case.

Registry Values

To disable history, set the DWORD registry value DisableHistory to 1 either under HKEY_LOCAL_MACHINE
or under HKEY_CURRENT_USERinthe LocalData location: \software\sap\SAPGUI Front\SAP
Frontend Server\LocalData.

i Note

When using a 32bit SAP GUI for Windows on a 64bit operating system , the value under
HKEY_LOCAL_MACHINE needs to be placed under:

HKEY_LOCAL_MACHINE\software\Wow6432Node\sap\SAPGUI Front\SAP Frontend
Server\LocalData

The reading order is as follows:

First, the registry value will be checked under HKEY_LOCAL_MACHINE. If not defined there, the registry value
will be checked under HKEY_CURRENT_USER.

10.4 Disabling/Setting Read-Only the Local Tab Order via
Registry

You have the possibility to completely disable the local tab order functionality via registry or to set it read-only.

Registry Values

[HKEY_LOCAL_MACHINE\SOFTWARE\SAP\SAPGUI Front\SAP Frontend Server\lLocalData]

[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\SAP\SAPGUI Front\SAP Frontend
Server\LocalData] (32bit SAP GUI for Windows on a 64bit operating system)

DisableLocalTabChain (= 1 means local tab order disabled)

LocalTabOrdexrReadOnly (= 1 means local tab order read-only)
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11 Appendix

11.1 Related Information

Source Location

SAP Community SAP GUI Community #&

SAP GUI Family wiki®r

SAP Help Portal SAP GUI Online Help

11.2 Registry Keys Overview

The following registry key overview contains the registry keys as titles and the registry key data in the table
following the title.

11.2.1 Software\SAP\General

Value Type Default Reading Priority Chapter/Reference
AccMode REG_SZ off HKCU — HKLM Accessibility Page
[page 69]
AllOptionsReadOnly = REG_DWORD See ref. See ref. Read-Only Feature of
the SAP GUI Options
Dialog [page 27]
BrowserControl REG_DWORD 1 HKCU — HKLM Control Settings Page
[page 66]
BrowserControlFall- REG_SZ See ref. HKCU — HKLM SAP Note 2957665 #r

backConfiguration
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Value Type Default Reading Priority Chapter/Reference
CurRegValReadOn- REG_DWORD See ref. See ref. Read-Only Feature of
lyActive the SAP GUI Options
Dialog [page 27]
EdgeBrowserEnable- REG_DWORD 0 HKLM = HKCU SAP Note 2955264 %
DevToolsWindow
EdgeBrowserContro- REG_DWORD 1 HKCU — HKLM SAP Note 2942740 far
IUseSAPGUIFont
Language REG_SZ OS default language HKCU — HKLM SAP Logon Options -
General Page [page
86]
OfficeOutplaceMode e 7 Off HKCU — HKLM Accessibility Page
[page 69]
SAPDockAllowMove- REG_DWORD 0 HKCU — HKLM Control Settings Page
Save [page 66]
SAPGUIControlPlugin REG_DWORD 0 HKCU — HKLM Control Settings Page

[page 66]

11.2.2 Software\SAP\General\Appearance

Value Type Default Reading Priority Chapter/ Reference

AccClassicMenubar- REG_DWORD 1 HKCU — HKLM see note 1515235/

BehaviorActive

ActivateFioriFeatures REG_DWORD 1 HKCU — HKLM Theme Settings Page
[page 28]

AdjustFontHeight- REG_DWORD 1 HKCU — HKLM see note 21063237

ToDPI

AnimatedFocus REG_DWORD 1 HKCU — HKLM Theme Settings Page
[page 28]

BelizeDefault Color REG_SZ HKCU = HKLM SAP GUI Default Color
[page 22]

BlueCrystalDefault- REG_SZ " HKCU — HKLM SAP GUI Default Color

Color

[page 22]
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Value Type Default Reading Priority Chapter/ Reference
Brandinglmage REG_SZ none HKCU — HKLM Branding Page [page
36]
Brandinglmage_Re- REG_DWORD 0 only HKLM Branding Page [page
adOnly 36]
CIearRLoca(I)TaIbOr- REG_DWORD 0 only HKLM Restore & Clean Up
der_ReadOnly Page [page 92]
Corbulcon REG_DWORD 0 HKCU — HKLM Theme Settings Page
[page 28]
EllipsisForl18n REG_DWORD 0 HKCU = HKLM Visualization 2 Page
[page 63]
ExportConfiguratio- REG_DWORD 0 only HKLM Eesto[re & Clgeza]rgutp
. ) age [page ata
nAndSettings_Re Migration for End
adOnly Users [page 9]
FioriToolbarButtons- REG_DWORD 0 HKCU — HKLM Theme Settings Page
Withlcons [page 28]
FrontEndPrint_Re- REG_DWORD 0 only HKLM Frontend Print Settings
adOnly Page [page 91]
ImportConfiguratio- REG_DWORD 0 only HKLM Eesto[re & C|9e;]r1DUtp
. ) age [page ata
nAndSettings_Re Migration for End
adOnly Users [page 9]
LunarFollowFocusMe- REG_DWORD 0 HKCU — HKLM see note 1552357 Fr
nuActive
MultiMonitorDpiA-  REG_DWORD 0 HKCU — HKLM Theme Settings Page
[page 28]
wareness
QuartzDefaultColor ~ RECG-SZ 0 HKCU — HKLM SAP GUI Default Color
[page 22]
QuartzDarkDefault-  REG-SZ 0 HKCU — HKLM SAP GUI Default Color
Color [page 22]
RestoreDefaults_Re- REG_DWORD 0 HKLM Restore & Clean Up
adOnly Page [page 92]
SelectedFallback- REG_DWORD 256 HKCU — HKLM Theme Settings Page
Theme [page 28]
SelectedTheme REG_DWORD 256 HKCU — HKLM Theme Settings Page
[page 28]
ShowINSOVR REG_DWORD 0 HKCU — HKLM Theme Settings Page

[page 28]
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Value Type Default Reading Priority Chapter/ Reference
ShowShadowBorder = REG_DWORD 1 HKCU — HKLM Theme Settings Page
[page 28]
SignatureDefault- REG_SZ " HKCU — HKLM Color Settings Page
Color [page 40]
SignatureSystemDe- REG_DWORD 1 HKCU = HKLM Color Settings Page
pendentColorsActive [page 40]
SND_CHECKBOX_RA- REG_EXPAND_SZ undefined HKCU — HKLM Sound Settings Page
DIOBUTTON_CLICK [page 67]
SND_DIALOG- REG_EXPAND_SZ undefined HKCU — HKLM Sound Settings Page
BOX_OPEN [page 67]
SND_MESSAGE_ER- REG_EXPAND_SZ undefined HKCU — HKLM Sound Settings Page
ROR [page 67]
SND_MESSAGE_SUC- REG_EXPAND_SZ undefined HKCU — HKLM Sound Settings Page
CESS [page 67]
SND_MES- REG_EXPAND_SZ undefined HKCU — HKLM Sound Settings Page
SAGE_WARNING [page 67]
SND_PUSHBUT- REG_EXPAND_SZ undefined HKCU — HKLM Sound Settings Page
TON_CLICK [page 67]
SND_TABCON- REG_EXPAND_SZ undefined HKCU — HKLM Sound Settings Page
TROL_CLICK [page 67]
SND_TREE_EX- REG_EXPAND_SZ undefined HKCU — HKLM Sound Settings Page
PAND_COLLAPSE [page 67]
Sound REG_SZ off; in accessibility HKCU — HKLM Sound Settings Page
mode: On [page 67]
SoundLibrary REG_DWORD 0 - SAP Ethno HKCU — HKLM Sound Settings Page
[page 67]
TreeBackgroundCo- REG_DWORD 0 HKCU — HKLM SAP Note 2943146 ¥
lorPerLevel
UseBrandinglmage REG_DWORD 0 HKCU — HKLM Branding Page [page
36]
UseBranding- REG_DWORD 1 HKCU — HKLM Branding Page [page
Image_ReadOnly 36]
UseGuiHelpOnly REG_SZ Off only HKLM see note 694583 M
UseListColorSetting REG_DWORD 1 HKCU — HKLM Classic Design - Color

in Lists Page [page 55]

100 PUBLIC

SAP GUI Administration
Appendix


http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2943146
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/694583

11.2.3 Software\SAP\General\Appearance\Systems

Value Type Default Reading Priority Chapter/Reference
BrandingSystemSpe- REG-DWORD 1 HKLM Brandi;g in System
cific_ReadOnly [page 37]
ColorsSystemSpe- REG_DWORD 0 HKLM Colors in System Page

cific_Readonly

[page 46]

11.2.4 Software\SAP\General\Appearance\Systems\SID

Value Type Default Reading Priority Chapter/Reference
Brandinglmage REG_SZ HKCU = HKLM Using System/Client-
specific Branding
[page 17]
Folder4SystemSpeci- REG_SZ "Branding" in SAP GUI HKCU = HKLM Using System/Client-
ficBranding InstallDir specific Branding
[page 17]
ThemeNameBC REG_SZ Registry key and value  HKCU — HKLM CoIorsAi?5 System Page
do not exist [page 46]
ThemeNameBelize REG_SZ Registry key and value HKCU — HKLM Colors4ig System Page
do not exist [page 46]
ThemeName Quartz REG_SZ Registry key and value HKCU — HKLM Colors in System Page
) [page 46]
do not exist
ThemeNameQuartz- REG_SZ Registry key and value HKCU — HKLM Colors in System Page
: [page 46]
Dark do not exist

11.2.5 Software\SAP\General\Appearance\Systems\SID\CIi
ent_NO

Value

Type

Default

Reading Priority

Chapter/Reference

Brandinglmage

REG_SZ

HKCU — HKLM

Using System/Client-
specific Branding
[page 17]
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Value Type

Default Reading Priority Chapter/Reference

ThemeName REG_SZ Registry key and value HKCU — HKLM Colors in System Page
do not exist [page 46]
ThemeNameBC REG_SZ Registry key and value  HKCU — HKLM Colors in System Page

do not exist [page 46]

ThemeNameBelize REG_SZ

Registry key and value  HKCU — HKLM Colors in System Page
do not exist [page 46]

ThemeNameQuartz REG_SZ

Registry key and value HKCU — HKLM Colors in System Page
do not exist [page 46]

ThemeNameQuartz- REG_SZ
Dark

Registry key and value  HKCU — HKLM Colors in System Page
do not exist [page 46]

11.2.6 SOFTWARE\SAP\General\Appearance\Themes

Value Type Default Reading Priority Chapter/Reference
SelectableThemes REG_DWORD none only HKLM Theme Settings Page
[page 28]

The usable themes
must be explicitely
specified. When using
a wrong value, all
themes are displayed.

11.2.7 Software\SAP\General\Applications\<application>

Value Type Default Reading Priority Chapter/Reference
AppsSapGuiVisualTh- REG_DWORD 0 only HKLM Applications Page
eme_ReadOnly [page 58]
MouseFollowFocus REG_DWORD 0 KCU — HKLM Keyboard Settings

Page [page 60]

102 PUBLIC

SAP GUI Administration
Appendix



11.2.8 Software\SAP\General\ControlServices\WebSearchEn

gine

Value Type Default

Reading Priority

Chapter/Reference

WebSearchEngine REG_SZ Google

HKCU — HKLM

Control Settings Page
[page 66]

11.2.9 Software\SAP\General\Customer Colors

Value Type Default

Reading Priority

Chapter/Reference

CustomColors_Re- REG_DWORD 0

adOnly

only HKLM

Define Custom Colors
(SAP Signature) [page
39]

11.2.10 Software\SAP\General\Customer Colors\Custom

Color1
Value Type Default Reading Priority Chapter/Reference
Hue REG_DWORD No default = value HKCU — HKLM Define Custom Colors
must exist (SAP Signature) [page
39]
11.2.11 Software\SAP\SAP Shared
Value Type Default Reading Priority Chapter/Reference
SAPhistoryDir REG_SZ_EXPAND See ref. only HKLM Roaming User Applica-

tion Directory [page 6]

History Page [page 76]
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Value Type Default Reading Priority Chapter/Reference

SAPWorkDir REG_SZ_EXPAND See ref. only HKLM Roaming User Applica-
tion Directory [page 6]

11.2.12 Software\SAP\SAPGUI

Value Type Default Reading Priority Chapter/Reference

DelegationMode REG_DWORD 0 HKCU — HKLM SAP Note 844095
StartSaplogon REG_DWORD 1 HKLM — HKCU SAP Note 552646
NoDelegate REG_DWORD 0 Only HKLM SAP Note 844095

11.2.13 Software\SAP\SAPGUI Front\SAP Frontend
Server\Accessibility

Value Type Default Reading Priority Chapter/Reference

EnhancedTabChain REG_DWORD 1 HKCU — HKLM Accessibility Page
[page 69]

SymbolAsLetters REG_DWORD 1 HKCU — HKLM Accessibility Page
[page 69]

11.2.14 Software\SAP\SAPGUI Front\SAP Frontend
Server\Administration

Value Type Default Reading Priority Chapter/Reference
Disappearitems REG_SZ 1 only HKLM SAP Note 338750 ¥
ShowAdditionalTi- REG_DWORD 0 HKCU — HKLM Visualization 2 Page
tlelnfo [page 63]
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11.2.15 Software\SAP\SAPGUI Front\SAP Frontend

Server\Customize

Value Type Default Reading Priority Chapter/Reference

AdjustFontToKL REG_DWORD 0 HKCU — HKLM Encoding Page [page
73]

AdjustFontToSapCP REG_DWORD 1 HKCU — HKLM Encoding Page [page
73]

AlvCellArrowNaviga- REG-DWORD 0 HKCU — HKLM 2910148/

tion

AlvinitialFocusPosi- REG_DWORD 0 HKCU — HKLM SAP Note 2973107

tion

Automation.Message- REG_DWORD 8 seconds HKCU — HKLM SAP Note 87585 #

PendingDelay

Automation.RetryRe- REG_DWORD 10 seconds HKCU — HKLM SAP Note 87585 ¥

ply

AutoTAB REG_DWORD 0 HKCU — HKLM Keyboard Settings
Page [page 60]

BeepError REG_DWORD 0 HKCU — HKLM Notifications Page
[page 64]

BidirectOnLang REG_DWORD 1 HKCU — HKLM Others Page [page 75]

BubbleDelay REG DWORD 1 HKCU — HKLM Notifications Page

- [page 64]

BubbleOnTab REG_DWORD 0 HKCU — HKLM Notifications Page
[page 64]

Buttonbar REG_DWORD 1 HKCU — HKLM Classic Design - Op-
tions Page [page 53]

CheckDynproSize REG_DWORD 0 HKCU — HKLM SAP Note 570861 %%

ColorScheme REG_DWORD 0 HKCU — HKLM Classic Design - Op-
tions Page [page 53]

CopyAndPasteTabSe- REG_DWORD 0 HKCU — HKLM Keyboard Settings

parated Page [page 60]

DbIClkForF2 REG_DWORD 1 HKCU — HKLM SAP Note 1672400 ¥

Dropdown.Keyboard- REG_DWORD 1000 milliseconds HKCU — HKLM SAP Note 352130 #%

Delay_ms

Dropdown.ShowKey =~ REG_DWORD 0 HKCU — HKLM Visualization 1 Page
[page 61]

Dropdown.SortKey REG_DWORD 0 HKCU — HKLM Visualization 1 Page

[page 61]
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Value Type Default Reading Priority Chapter/Reference
Edit.BlockCursor REG_DWORD 0 HKCU — HKLM Visualization 1 Page
[page 61]
Edit.CaretWidth REG_DWORD 2 HKCU — HKLM Visualization 1 Page
[page 61]
Edit.EnterFieldSelec- REG_DWORD 1 HKCU — HKLM Keyboard Settings
tAll Page [page 60]
EnhancedSearch- REG_DWORD 1 HKCU — HKLM Visualization 2 Page
Mode [page 63]
GraphicSettings_Re- REG_DWORD 0 only HKLM Graphic Page [page 74]
adOnly
HideCmdLinelnplace REG_DWORD 0 HKCU — HKLM SAP Note 648452 s
HideCmdLinelnpla- REG_DWORD 0 HKCU — HKLM SAP Note 648452 #
ceAllSession
HideCmdLinePerma- REG_DWORD 0 HKCU — HKLM Displaying OK Code
nently Field and Status Bar
Info [page 95]
ImeCloseOneByte REG_DWORD 0 HKCU — HKLM IME Page [page 72]
ImeCloseRJustify REG_DWORD 0 HKCU — HKLM IME Page [page 72]
KanjiContlnput REG_DWORD 0 HKCU — HKLM IME Page [page 72]
KanjiHideShortcut REG_DWORD 0 HKCU — HKLM Others Page [page 75]
KanjiKey REG_DWORD 0 HKCU — HKLM IME Page [page 72]
KanjiSuppressPFKey = REG_DWORD 0 HKCU — HKLM Others Page [page 75]
LatinlAutoDetect REG_DWORD 0 HKCU — HKLM Encoding Page [page
73]
ListAllowClearType REG_DWORD 1 HKCU — HKLM Visualization 1 Page
[page 61]
ListCursor REG_DWORD 1 HKCU — HKLM Visualization 1 Page
[page 61]
ListEffect REG_DWORD 1 HKCU — HKLM Classic Design - Color
in Forms Page [page
57]
ListLines REG_DWORD 1 HKCU — HKLM Visualization 1 Page
[page 61]
MainMenulnMoreBut- REG_DWORD 0 HKCU — HKLM Theme Settings Page
ton [page 28]
PopupBatchin REG_DWORD 1 HKCU — HKLM Visualization 1 Page
[page 61]
PopupError REG_DWORD 0 HKCU — HKLM Notifications Page
[page 64]
PopupSuccess REG_DWORD 0 HKCU — HKLM Notifications Page

[page 64]
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Value Type Default Reading Priority Chapter/Reference
PopupWarning REG_DWORD 0 HKCU — HKLM Notifications Page
[page 64]
PositionMouse REG_DWORD 1 HKCU — HKLM Keyboard Settings
Page [page 60]
PositionTAB REG_DWORD 1 HKCU — HKLM Keyboard Settings
Page [page 60]
ScrollDelay REG_DWORD 0 HKCU — HKLM SAP Note 740052
Shadow REG_DWORD 1 HKCU — HKLM Classic Design - Color
in Forms Page [page
57]
ShowAdditionalTi- REG_DWORD 0 HKCU — HKLM Visualization 2 Page
tlelnfo [page 63]
Show placeholder REG_DWORD 1 HKCU — HKLM Visualization 2 Page
characters [page 63]
Simulate Workplace REG_DWORD 1000 HKCU — HKLM SAP Note 352130 #%
Statusbar REG_DWORD 1 HKCU — HKLM Classic Design - Op-
tions Page [page 53]
Statusbar.Layout REG_DWORD 1 HKCU — HKLM Displaying OK Code
Field and Status Bar
Info [page 95]
StatusShowMode REG_DWORD 1 HKCU — HKLM SAP Note 2565051
StatusShowModeBel- REG_DWORD 0 HKCU — HKLM SAP Note 2565051
ize
Toolbar REG_DWORD 1 HKCU — HKLM Classic Design - Op-
tions Page [page 53]
Toolbar.RegularBut- REG_DWORD 0 HKCU — HKLM Classic Design - Op-
tons tions Page [page 53]
UnderlineHotspot REG_DWORD 0 HKCU — HKLM Visualization 1 Page
[page 61]
UseClientAccesskeys REG_DWORD AccMode enabled >1 HKCU — HKLM Keyboard Settings
otherwise O Page [page 60]
UseSaplogonLang REG_DWORD 0 HKCU — HKLM Others Page [page 75]

11.2.16 Software\SAP\SAPGUI Front\SAP Frontend
Server\FontSettings

i Note

The registry keys CurrentCharSet and FontExpertMode can be found directly in the main path
HKEY_CURRENT_USER\SOFTWARE\SAP\SAPGUI Front\SAP Frontend Server\FontSettings. All
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other registry keys can be found in a character set-specific subdirectory, for example the values for the
character set , Japanese (Shift-JIS)" can be found under HKEY_CURRENT_USER\ SOFTWARE\ SAP\ SAPGUI
Front\SAP Frontend Server\FontSettings\128.

Value Type Default Reading Priority Chapter/Reference
Fiori3.Font.Height REG_DWORD Oxfffffff2 ==-14 HKCU — HKLM Font Setting Page
[page 31]
Fiori3.Font.Width REG_DWORD 0 HKCU — HKLM Font Setting Page
[page 31]
Fiori3.Font.Facename REG_SZ Depends on the set HKCU — HKLM Font Setting Page
charset [page 31]
Fiori3.Prop.Height REG_DWORD Oxfffffff2 == -14 HKCU — HKLM Font Setting Page
[page 31]
Fiori3.Prop.Width REG_DWORD 0 HKCU — HKLM Font Setting Page
[page 31]
Fiori3.Prop.Facename REG_SZ Depends on the set HKCU — HKLM Font Setting Page
charset [page 31]
Font.Basic.ScaleFac- REG_DWORD 100 (decimal) HKCU — HKLM Font Setting Page
tor [page 31]
Font.CharSet REG_DWORD Set system charsetor HKCU — HKLM Font Setting Page
0 [page 31]
FontExpertMode REG_DWORD 0 HKCU — HKLM Font Setting Page
[page 31]
Font.Expert.ScaleFac- REG_DWOR 100 (decimal) HKCU — HKLM Font Setting Page
tor [page 31]
Font.Facename REG_SZ Depends on the set HKCU — HKLM Font Setting Page
charset [page 31]
Font.Height REG_DWORD 15 HKCU — HKLM Font Setting Page
[page 31]
Font.Width REG_DWORD 0 HKCU — HKLM Font Setting Page
[page 31]
Prop.CharSet REG_DWORD Set system charsetor HKCU — HKLM Font Setting Page
0 [page 31]
Prop.Expert.ScaleFac- REG_DWORD 100 (decimal) HKCU — HKLM Font Setting Page
tor [page 31]
Prop.Facename REG_DWORD Depends on the set HKCU — HKLM Font Setting Page
charset [page 31]
Prop.Height REG_DWORD 15 HKCU — HKLM Font Setting Page
[page 31]
Prop.Width REG_DWORD 0 HKCU — HKLM Font Setting Page

[page 31]
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11.2.17 Software\SAP\SAPGUI Front\SAP Frontend

Server\LocalData
Value Type Default Reading Priority Chapter/Reference
ClearLocalTabOr- REG_DWORD 0 only HKLM Local Tab Order Page
der_ReadOnly [page 81]
DataPath REG_SZ %APP- HKCU — HKLM History Page [page 76]
DATA%\SAP\SAP
GUNHistory
DeleteDocuments REG_DWORD 0 HKCU — HKLM File Lifetime Page
[page 79]
DeleteTraces REG_DWORD 1 HKCU — HKLM File Lifetime Page
[page 79]
DisableHistory REG_DWORD 0 HKCU — HKLM SAP Note 925639
orDisabling Input His-
tory via Registry [page
96]
DisableLocalTabChain REG_DWORD 0 only HKLM Disabling/Setting
Read-Only the Local
Tab Order via Registry
[page 96]
DocumentLifetime REG_DWORD 0 HKCU — HKLM File Lifetime Page
[page 79]
Expiration REG_DWORD 3 HKCU — HKLM History Page [page 76]
FieldLenHistoryOn REG_DWORD 59 HKCU — HKLM History Page [page 76]
FileSize REG_DWORD 10 HKCU — HKLM History Page [page 76]
LocalTabOrderPath REG_EXPAND_SZ %APP- HKCU — HKLM Local Tab Order Page
DATA%\SAP\SAP [page 81]
GUNLocalTabOrder
LocalTabOrderRea- REG_DWORD 0 only HKLM Disabling/Setting
dOnly Read-Only the Local
Tab Order via Registry
[page 96]
MaxCacheFileSize REG_DWORD 1024 HKCU — HKLM Cache Page [page 77]
MaxCacheSize REG_DWORD 10 HKCU — HKLM Cache Page [page 77]
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Value Type Default Reading Priority Chapter/Reference

NoEntries REG_DWORD 20 HKCU — HKLM History Page [page 76]

ShowMode REG_DWORD 1 HKCU — HKLM History Page [page 76]

TraceLifetime REG_DWORD 1 HKCU — HKLM File Lifetime Page
[page 79]

UseDot REG_DWORD 0 HKCU — HKLM SAP Note 867131 #%

11.2.18 Software\SAP\SAPGUI Front\SAP Frontend

Server\Palette

Value Type Default Reading Priority Chapter/Reference

Edit.BgndBrush REG_SZ 255 255 255 HKCU — HKLM Classic Design - Color
in Forms Page [page
57]

Edit.FocusBrush REG_SZ 255 255 255 HKCU — HKLM Classic Design - Color
in Forms Page [page
57]

Edit.TextInt REG_SZ 25500 HKCU — HKLM Classic Design - Color
in Forms Page [page
57]

Edit.TextNorm REG_SZ 000 HKCU — HKLM Classic Design - Color
in Forms Page [page
57]

Frame.BgndBrush REG_SZ Same value as HKCU — HKLM Classic Design - Color

Read.BgndBrush in Forms Page [page

57]

IntensiveColorl REG_SZ 125166 207 HKCU — HKLM Classic Design - Color

Till 196 150 207 in Lists Page [page 55]

IntensiveColor7

IntensiveTextl REG_SZ 000 HKCU — HKLM Classic Design - Color

Till 000 in Lists Page [page 55]

IntensiveText7
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Value Type Default Reading Priority Chapter/Reference
InverseColorl REG_SZ 192192192 HKCU — HKLM Classic Design - Color
in Lists P 55
Till 192192 192 In Lists Page [page 55]
InverseColor7
InverseTextl REG_SZ 00255 HKCU — HKLM Classic Design - Color
in Lists P
Till 2040204 in Lists Page [page 55]
InverseText7
NormalColorl REG_SZ 255128128 HKCU — HKLM Classic Design - Color
in Lists P 55
till 227199 235 in Lists Page [page 55]
NormalColor7
NormalTextl REG_SZ 000 HKCU — HKLM Classic Design - Color
Till 000 in Lists Page [page 55]
NormalText7
Palette REG_DWORD 0 HKCU — HKLM Classic Design - Color
in Forms Page [page
57]
Read.BgndBrush REG_SZ System- defined value  HKCU — HKLM Classic Design - Color
for "Face color for in Forms Page [page
three-dimensional dis- 57]
play elements and
for dialog box back-
grounds"
Read.FocusBrush REG_SZ Same value as HKCU — HKLM Classic Design - Color
Read.BgndBrush in Forms Page [page
57]
Read.TextInt REG_SZ 25500 HKCU — HKLM Classic Design - Color
in Forms Page [page
57]
Read.TextNorm REG_SZ 000 HKCU — HKLM Classic Design - Color
in Forms Page [page
57]
Static.TextInt REG_SZ 25500 HKCU — HKLM Classic Design - Color

in Forms Page [page
57]
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Value Type Default Reading Priority Chapter/Reference

Static.TextNorm REG_SZ 000 HKCU — HKLM Classic Design - Color
in Forms Page [page
57]
View.BgndBrush REG_SZ Same value as HKCU — HKLM Classic Design - Color
Read.BgndBrush in Forms Page [page
57]

11.2.19 Software\SAP\SAPGUI Front\SAP Frontend

Server\ReleaseDebug
Value Type Default Reading Priority Chapter/Reference
Debug.Hotkeys REG_DWORD 0 HKCU — HKLM SAP Note 422044
UnhandledException- REG_DWORD 1 Only HKCU SAP Note 559285 ¥

sOnly

11.2.20 Software\SAP\SAPGUI Front\SAP Frontend
Server\ReleaseDebug\ShowBorders

Value Type Default Reading Priority Chapter/Reference
CMyManager.ShowB- REG_DWORD 0 HKCU — HKLM SAP Note 324687 Fi
orders

CMyManager.Show- REG_DWORD 0 HKCU — HKLM SAP Note 324687 #
Names

ENABLED REG_DWORD 0 HKCU — HKLM SAP Note 324687 P
SHOW_ALL REG_DWORD 1 HKCU — HKLM SAP Note 324687 P
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11.2.21 Software\SAP\SAPGUI Front\SAP Frontend

Server\SapChart
Value Type Default Reading Priority Chapter/Reference
Mirror REG_DWORD 0 HKCU — HKLM SAP Note 1287485 P

11.2.22 Software\SAP\SAPGUI Front\SAP Frontend

Server\Scripting

Value Type Default Reading Priority Chapter/Reference
DisableWriteToDisk REG_DWORD 0 only HKLM SAP Note 867260 M
RecordingWindow- REG_DWORD 0 HKCU — HKLM SAP Note 2953860#%
TopMost

SetSapWorkDirOnO- REG_DWORD 1 HKCU — HKLM SAP Note 1270130 #
penConn

ShowNativeWinDlgs REG DWORD 0 HKCU = HKLM Scripting Page [page

B 70]

WaitForResponsel REG_DWORD 1 HKCU — HKLM SAP Note 867260 #&

11.2.23 Software\SAP\SAPGUI Front\SAP Frontend

Server\Security
Value Type Default Reading Priority Chapter/Reference
ActivateLogging REG_DWORD 0 only HKLM See chapter Central

Repository for Secur-
ity Configuration in the
SAP GUI for Windows
Security Guide
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Value

Type

Default

Reading Priority

Chapter/Reference

Configuration

REG_DWORD

only HKLM

See chapter Central
Repository for Secur-
ity Configuration in the
SAP GUI for Windows
Security Guide

DefaultAction

REG_DWORD

HKLM -> HKCU

See chapter Central
Repository for Secur-
ity Configuration in the
SAP GUI for Windows
Security Guide

DeleteAllUserDefi-
nedSecurityRules_Re-
adOnly

REG_DWORD

only HKLM

Restore & Clean Up
Page [page 92]

DisplayNotifications

REG_DWORD

only HKLM

See chapter Central
Repository for Secur-
ity Configuration in the
SAP GUI for Windows
Security Guide

DP.KeepAlive

REG_DWORD

only HKLM

SAP Note 701618 ¥4

InitSaveDir

REG_EXPAND_SZ

none

only HKLM

See chapter Central
Repository for Secur-
ity Configuration in the
SAP GUI for Windows
Security Guide

Location

REG_EXPAND_SZ

none

only HKLM

See chapter Central
Repository for Secur-
ity Configuration in the
SAP GUI for Windows
Security Guide

LoggingDestination-
Dir

REG_EXPAND_SZ

none

only HKLM

See chapter Central
Repository for Secur-
ity Configuration in the
SAP GUI for Windows
Security Guide

SecurityLevel

REG_DWORD

HKLM ->HKCU

See chapter Central
Repository for Secur-
ity Configuration in the
SAP GUI for Windows
Security Guide
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Value Type Default Reading Priority Chapter/Reference

UserRuleEditing_Re- REG_DWORD 0 only HKLM Security Settings Page

adOnly [page 85]

UserScripting REG_DWORD 1 HKCU — HKLM Scripting Page [page
70]

WarnOnAttach REG_DWORD 1 only HKCU Scripting Page [page
70]

WarnOnConnection REG_DWORD 1 only HKCU Scripting Page [page
70]

11.2.24 Software\SAP\SAPGUI Front\SAP Frontend

Server\Trace
Value Type Default Reading Priority Chapter/Reference
SessionTrace_Re- REG_DWORD 0 only HKLM Session Traces Page
adOnly [page 82]

11.2.25 Software\SAP\SAPGUI Front\SAP Frontend

Server\Window
Value Type Default Reading Priority Chapter/Reference
Maximize REG_DWORD 0 only HKCU SAP Note 103019#%

11.2.26 Software\SAP\SAPGui\Administration

Value Type Default Reading Priority Chapter/Reference

UpDownload_CP REG_DWORD see note HKCU — HKLM SAP Note 1073779/
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11.2.27 Software\SAP\SAPGui\Trace

Value

Type

Default

Reading Priority

Chapter/Reference

Level_ReadOnly

REG_DWORD

only HKLM

SAP GUI Traces Page
[page 83]

11.2.28 Software\SAP\SAPLogon

Value Type Default Reading Priority Chapter/Reference
AutoClose REG_DWORD 1 HKLM — HKCU SAP Note 743482/
CertErrorHandling- REG_DWORD 0 only HKLM SAP Note 2892419
Mode
HideColumnGrou- REG_DWORD 1 (hidden) HKLM — HKCU SAP Note 806296 /%
temTab
pServerOnSystemTa 0 (displayed)
HideColumnMessage- REG-DWORD 1 (hidden) HKLM = HKCU SAP Note 806296
S OnSystemTab
erverOnSystemTa 0 (displayed)

HideColumnRouter- REG_DWORD 1 (hidden) HKLM — HKCU SAP Note 806296 i
OnSystemTab

O (displayed)
HideColumnSIDOn- REG_DWORD 1 (hidden) HKLM — HKCU SAP Note 806296
SystemTab

O (displayed)
HideColumnSys- REG_DWORD 1 (hidden) HKLM — HKCU SAP Note 806296
NoOnSystemTab

O (displayed)
HideColumnSystem-  REG-DWORD 1 (hidden) HKLM — HKCU SAP Note 806296
D iptionOnSys-

escriptionOnSys 0 (displayed)

temTab
SearchLabelBySid REG_DWORD 1 HKLM — HKCU SAP Note 864215
ShowExplorerView REG_DWORD 1 none SAP Note 171086474
ShowListView REG_DWORD 1 none SAP Note 171086474
ShowTreeView REG_DWORD 1 none SAP Note 171086474
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Value Type Default Reading Priority Chapter/Reference
ShowWorkspaceView REG_DWORD 1 none SAP Note 17108647
WhitelistLandscape- REG_SZ see ref. only HKLM SAP Note 2892419 ¥
FilesForlgnoringCer-
tErrors
11.2.29 Software\SAP\SAPLogon\Options
Value Type Default Reading Priority Chapter/Reference
ActivateSNCSSOBy- REG_DWORD 0 HKLM — HKCU SAP Note 3074756
Default
AllowCachingServer- REG_DWORD 1 SAP Logon (Pad): SAP Logon Options
figFil - fi tion Fil
ConfigFiles HKCU = HKLM (HKLM Configuration Files
— HKCU) Page [page 88]
ConfirmDelete REG_DWORD 1 SAP Logon (Pad): SAP Logon Options -
G | P,
HKCU = HKLM (HKLM Sgnera age [page
— HKCU) ]
CorelLandscapefFi- REG_EXPAND_SZ SAP Logon (Pad): SAP Logon Options
leOnServer HKCU = HKLM (HKLM - Configuration Files
S HKCU) Page [page 88]
HideToTrayBar REG_DWORD 0 SAP Logon (Pad): SAP Logon Options -
G | P,
HKCU — HKLM (HKLM Sznera age [page
— HKCU) !
InitializeUserAsEmpty REG_DWORD 0 HKCU — HKLM SAP Note 103019 ¥
LandscapeCacheEx- REG_DWORD 0 SAP Logon (Pad): SAP Logon Options
piryPeriod HKCU = HKLM (HKLM - Configuration Files
— HKCU) Page [page 88]
LandscapeFileOn- REG_EXPAND_SZ SAP Logon (Pad): SAP Logon Options
Server HKCU — HKLM (HKLM - Configuration Files
S HKCU) Page [page 88]
MessageServerTime- REG_DWORD 10 SAP Logon (Pad): SAP Logon Options -
t | P,
ou HKCU — HKLM (HKLM Sg”era age [page
— HKCU) ]

SAP GUI Administration
Appendix

PUBLIC 117


http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/1710864
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2892419
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/3074756
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/103019

Value Type Default Reading Priority Chapter/Reference
NoEditFunctionality REG_DWORD 0 SAP Logon (Pad): SAP Logon Options -
G | P,
HKCU — HKLM (HKLM Sznera age [page
— HKCU) !
NoSortingToSystem- REG_DWORD 0 HKLM only SAP Note 2616226
DescriptionInSAP-
Shortcut
PathConfigFilesLocal REG_EXPAND_SZ %APP- SAP Logon (Pad): SAP Logon Options
DATA%\SAP\Com- HKCU — HKLM (HKLM l-DConfiguratisogn Files
mon > HKCU) age [page 88]
SapguiNTCmdOpts REG_SZ SAP Logon (Pad): SAP Logon Options -
| P,
HKCU — HKLM (HKLM :znera age [page
— HKCU) ]
SAPLogonTracele- REG_DWORD 0 only HKLM SAP GUI Traces Page
vel_ReadOnly [page 83]
SingleSystemStatu- REG_SZ HKLM only SAP Note 2268554 #
sURL
SystemStatusURL REG_SZ HKLM only SAP Note 2268554
UseSAPLogonLangua- REG_DWORD 1 SAP Logon (Pad): SAP Logon Options -
geAsDefault HKCU = HKLM (HKLM :gneral Page [page
— HKCU) ]

11.2.30 Software\SAP\SAPLogon\Settings

Value Type Default Reading Priority Chapter/Reference
CurrentNewSapLo- REG_SZ 3 (Workspace View) HKCU — HKLM SAP Note 2336740/
Vi

gonview Other values: O (Ex-

plorer View), 1 (Tree

View), 2 (List View)
DisplaySplashScreen REG_DWORD 0 HKCU — HKLM SAP Note 1588886 Fi
LastSelectedNodeKey REG_SZ HKCU = HKLM SAP Note 23367407
LastSelectedNode- REG_SZ HKCU — HKLM SAP Note 23367404

Type
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Value Type Default Reading Priority Chapter/Reference
SplashOff REG_SZ 1 HKCU — HKLM SAP Note 1583886 #w
SplitterPosition REG_SZ splitter size of the left ~ HKCU — HKLM SAP Note 1992105

pane in %

11.2.31 Software\SAP\SAPLogon\Settings\Connections

Value Type Default Reading Priority Chapter/Reference

ColumnWidthl REG_SZ 100 HKCU — HKLM SAP Note 3099771

ColumnWidth<N> REG.SZ dfnpends on the col- HKCU — HKLM SAP Note 3099771
umn

ColumnOrderl REG_DWORD 0 HKCU — HKLM SAP Note 3099771#%

ColumnOrder<N> REG_DWORD El;p:nds on the col- HKCU — HKLM SAP Note 30997717

SortDirection REG_DWORD 0 (Ascending) HKCU — HKLM SAP Note 3099771

SortedColumn REG_DWORD O (Index of the first col- HKCU — HKLM SAP Note 3099771
umn)

TREE_COL- REG_SZ 500 only HKCU Width of column in

UMN_DESCR Tree View

TREE_COL- REG_SZ 300 only HKCU Width of columnin

UMN_NAME Tree View

11.2.32 Software\SAP\SAPLogon\Settings\Favorites

Value Type Default Reading Priority Chapter/Reference
ColumnWidthl REG_SZ 200 HKCU — HKLM SAP Note 3099771
ColumnWidth<N> REG.S7Z depends on the col- HKCU — HKLM SAP Note 3099771
umn
ColumnOrderl REG_DWORD 0 HKCU — HKLM SAP Note 30997717
ColumnOrder<N> REG_DWORD depends on the col- HKCU — HKLM SAP Note 30997717
umn
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Value Type Default Reading Priority Chapter/Reference
SortDirection REG_DWORD 0 (Ascending) HKCU = HKLM SAP Note 3099771#%
SortedColumn REG_DWORD O (Index of the first col- HKCU — HKLM SAP Note 3099771%%

umn)

11.2.33 Software\SAP\SAPLogon\Settings\Listview

Value Type Default Reading Priority Chapter/Reference

ColumnWidthl REG_SZ 100 HKCU — HKLM SAP Note 3099771

ColumnWidth<N> REG_SZ depends onthecol- oy — HKLM SAP Note 3099771#
umn

ColumnOrderl REG_DWORD 0 HKCU — HKLM SAP Note 30997717

ColumnOrder<N> REG_DWORD dependsonthecol-  pxey - HKLM SAP Note 3099771
umn

SortDirection REG_DWORD O (Ascending) HKCU — HKLM SAP Note 3099771#%

SortedColumn REG_DWORD 0 (Index of the first col- HKCU — HKLM SAP Note 3099771 %%

umn)

11.2.34 Software\SAP\SAPLogon\Settings\Shortcut

Value Type Default Reading Priority Chapter/Reference

ColumnWidthl REG_SZ 150 HKCU — HKLM SAP Note 3099771#

ColumnWidth<N> " peq s7 depends onthe col- oy — HKLM SAP Note 3099771
umn

ColumnOrderl REG_DWORD 0 HKCU = HKLM SAP Note 3099771

ColumnOrder<N> REG_DWORD depends on the col- HKCU — HKLM SAP Note 3099771
umn

SortDirection REG_DWORD O (Ascending) HKCU = HKLM SAP Note 309977174

SortedColumn REG_DWORD 0 (Index of the first col- HKCU — HKLM SAP Note 3099771 #

umn)
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11.2.35 Software\SAP\SAPLogon\Settings\Workspace

Value Type Default Reading Priority Chapter/Reference
ColumnWidthl REG_SZ 100 HKCU — HKLM SAP Note 3099771
ColumnWidth<N> REG.SZ depends on the col- HKCU = HKLM SAP Note 3099771%%
umn
ColumnOrderl REG_DWORD 0 HKCU — HKLM SAP Note 3099771
ColumnOrder<N> REG_DWORD depends on the col- HKCU — HKLM SAP Note 3099771
umn
SortDirection REG_DWORD 0 (Ascending) HKCU — HKLM SAP Note 3099771#%
SortedColumn REG_DWORD 0 (Index of the first col- HKCU — HKLM SAP Note 3099771#%
umn)
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Important Disclaimers and Legal Information

Hyperlinks

Some links are classified by an icon and/or a mouseover text. These links provide additional information.
About the icons:

®  Links with the icon o : You are entering a Web site that is not hosted by SAP. By using such links, you agree (unless expressly stated otherwise in your
agreements with SAP) to this:
®  The content of the linked-to site is not SAP documentation. You may not infer any product claims against SAP based on this information.
®  SAPdoes not agree or disagree with the content on the linked-to site, nor does SAP warrant the availability and correctness. SAP shall not be liable for any
damages caused by the use of such content unless damages have been caused by SAP's gross negligence or willful misconduct.
L]

Links with the icon ’h": You are leaving the documentation for that particular SAP product or service and are entering a SAP-hosted Web site. By using
such links, you agree that (unless expressly stated otherwise in your agreements with SAP) you may not infer any product claims against SAP based on this
information.

Videos Hosted on External Platforms

Some videos may point to third-party video hosting platforms. SAP cannot guarantee the future availability of videos stored on these platforms. Furthermore, any
advertisements or other content hosted on these platforms (for example, suggested videos or by navigating to other videos hosted on the same site), are not within
the control or responsibility of SAP.

Beta and Other Experimental Features

Experimental features are not part of the officially delivered scope that SAP guarantees for future releases. This means that experimental features may be changed by
SAP at any time for any reason without notice. Experimental features are not for productive use. You may not demonstrate, test, examine, evaluate or otherwise use
the experimental features in a live operating environment or with data that has not been sufficiently backed up.

The purpose of experimental features is to get feedback early on, allowing customers and partners to influence the future product accordingly. By providing your
feedback (e.g. in the SAP Community), you accept that intellectual property rights of the contributions or derivative works shall remain the exclusive property of SAP.

Example Code

Any software coding and/or code snippets are examples. They are not for productive use. The example code is only intended to better explain and visualize the syntax
and phrasing rules. SAP does not warrant the correctness and completeness of the example code. SAP shall not be liable for errors or damages caused by the use of
example code unless damages have been caused by SAP's gross negligence or willful misconduct.

Bias-Free Language

SAP supports a culture of diversity and inclusion. Whenever possible, we use unbiased language in our documentation to refer to people of all cultures, ethnicities,
genders, and abilities.
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© 2022 SAP SE or an SAP affiliate company. All rights reserved.

No part of this publication may be reproduced or transmitted in any form
or for any purpose without the express permission of SAP SE or an SAP
affiliate company. The information contained herein may be changed
without prior notice.

Some software products marketed by SAP SE and its distributors
contain proprietary software components of other software vendors.
National product specifications may vary.

These materials are provided by SAP SE or an SAP affiliate company for
informational purposes only, without representation or warranty of any
kind, and SAP or its affiliated companies shall not be liable for errors or
omissions with respect to the materials. The only warranties for SAP or
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additional warranty.
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their respective logos are trademarks or registered trademarks of SAP
SE (or an SAP affiliate company) in Germany and other countries. All
other product and service names mentioned are the trademarks of their
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